
All growth depends upon activity. Life is manifest only by action.  
There is no development physically or intellectually without effort. 

 Calvin Coolidge – Adequate Brevity.
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The Blended Educator:  
Advanced Activities

Now that we have looked at some 
of the key considerations associat-
ed with developing blended con-
tent, let us take the six activities 
we looked at in the pilot one step 
further, and explore advanced ver-
sions of each of those activities. 

The six activities are, Presentations 
Podcasts, Videos, Documents, 
Games, and Searching. 

For each of the six activities we 
have selected two tasks to give 
you some options to choose from.  

For each of these tasks we have 
detailed instructions as to how to 
start doing them. 

Each task is presented based on the following structure:  (See Table 4.1.) 

Table 4.1 – How the following sections are structured

What do I need?
This section covers what hardware and software is required for you to achieve this 
task.

Where to look for help?
This section mentions online and offline resources that will help you learn more 
about this task. 

How do I prepare?
We have mentioned it before: preparation is key before you start developing 
content. This section gives some advice on what to do to begin doing this task.

What do I do? This section details a step-by-step guide to doing this task.

Teaching benefits
This section lists some of the teaching benefits that can occur when you do this 
task. 

Common mistakes to 

avoid

This section looks at some of the common mistakes people make when 
developing and teaching this task.

Online or offline?
This section explains whether or not you need internet access for you and your 
learners to do this task.

Fig. 4.1 – Topics in this Chapter. 
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4.1 Presentations

Creating presentations is a really important skill to de-
velop for the blended educator. You may already use 
them in a classroom setting. In a blended context, how-
ever, it is important to remember to add a little more 
information into the presentations, to make them inde-
pendent units of learning.

In this section we’ll look at two tasks associated with 
presentations: creating infographics, and using Prezi, 
which is an online tool for creating presentations.

4.1.1 Creating Infographics with Canva

Infographics are poster-style representations of infor-
mation in a quick and clear way. The combination of 
text and graphics allows for the information to be more 
easily understood by readers.

As always, it is best you do this with totally within your 
own means. You could draw it on paper, or if you have 
good graphic design software available (e.g. Adobe Il-
lustrator, Adobe InDesign or Corel Draw) you could use 
this. 

In this book, and in this chapter, we do not assume that 
you have such expert tools available. Therefore, let us 
do this tasks by using  free online tools. 

Caveat: The advantage is that it is quick, and that it is 
free. The disadvantage is that the results often are boil-
erplate and standard using just a ready-made template. 
The templates available are usually overly perfect in 
visual appearance; carrying a particular aesthetic (start-
ing with the way they use type-faces). You can however 
reduce this by heavy editing, and creating your own de-
signs from scratch. But these disadvantages aside, you 
may find online tools for making infographics worth 
trying. 

For example, we managed to create the book cover 
(Fig. 4.1., this page) in about 4 minutes from a template 
available at www.canva.com:

What do I need?

 Computer

 Internet access

 The Canva site: www.canva.com

 Before using the Canva site you need to create an 
account. Click on the  link above and register for free.

Where to look for help?

 https://support.canva.com offers tutorials and step-by-
step user guides. As a complete novice, click Getting 
Started first. 

 You can also watch a wide range of Canva tutorials at  
https://designschool.canva.com/tutorials

Blend-it-well Handbook 

Fig. 4.1 –  Book cover quickly created using Canva, from a pre-
fabricated template. 
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How do I prepare?

 The first thing to do is develop a script for the top-
ic you want to cover. Write down the key words you 
need to mention about this topic, and based on 
these words create some sentences. (Some people 
do not do this by physically writing as they have 
some clear enough idea in their head. It simply 
depends on what type of a person you are. Taking 
notes can help in the beginning.)

 If you want to include photos, make sure you pay 
attention to copyright and that the photos are of ap-
propriate quality.

What do I do?

 Once you have registered you enter the application 
and land on your account page. 

 The application asks you what you want to design. 
Search around until you find “Infographic”. You can 
also type “Infographic” into the search field. (Add-
ing more information here about how to find that 
section on the Canva websites does not make much 
sense as website layouts can change quickly)  When 
we checked last in Apil 2019, the website looked like 
this: 

 In this case the icon for “Infographic” is bottom left. 
Click it. You will then get a number of ready-made 
designs for infographics to choose from.

(See Fig. 4.2.)

 By clicking on one of the templates the window with 
the selected template opens.

 By clicking on the template, the toolbar appears 
above the selected infographic. You can add text, 
photos, change the font, use colours etc.

Fig. 4.3 – Toolbar for editing content in Canva.

4.  The Blended Educator: Advanced Activities

Fig. 4.2 –  Ready-made designs offered by Canva. (Screenshot 
taken in late 2018.)
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(See Fig. 4.3)

 There is another menu on the left side of your page. 
The first icon is about templates. Once you have 
chosen the template, you can start playing with it: 
you can add different elements such as photos and 
graphics, add text, change background, upload your 
own photos, create folders and use one of many 
apps to further design your infographics.

 If you for example click on the Background’ icon, you 
are offered a number of free templates you can use 
to change the original one you selected.

1 Making sure that colour-blind people can read graphics is a science in itself, all the more as there are several types of colour-
blindness. A good point to start is watching your graphic with your eyes narrowed to slits. This helps you see contrast of 
brightness rather than colour.

 After choosing the background of your infographic, 
you can start playing with content by adding text. 
Click on “Text” and then drag and drop heading 
types. You can change font faces and colours.

 Under “Elements” you can add free photos, grids, 
frames, shapes, lines, illustrations, icons and charts 
to your infographic. To select a graphic element, se-
lect your chosen category, and then double-click the 
element, or drag and drop it to the editing screen. 

Teaching Benefits 

 BenefitsInfographics take textual information and 
convert it into a highly visual piece of content that 
people are more likely to read, understand, and re-
member.

 A good infographic can tell a story.

 Infographics encourage learners to think visually 
about topics.

 They can help learners to better remember statisti-
cal information.

Common Mistakes to Avoid

 You must define a clear entry point into your graph-
ics. That’s the thing to watch (or read) first. The oppo-
site is “weak flow”: that’s when the reader does not 
know where to look first. 

 You should organise your information clearly and 
effectively.

 Keep your colour palette small.

 Ensure you choose colours with good contrast. 
Some people have problems differentiating certain 
colours.1 

 Don’t forget your hierarchy.

Online or Offline?

 You can download your infographic in files: .jpg, 
.png or pdf

Blend-it-well Handbook 
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 You can share your infographics with your col-
leagues. Simply click the “Share” button on the top 
right of the editor.

4.  The Blended Educator: Advanced Activities
4.1.1 Creating Infographics with Canva

4



68

4.1.2 Creating a Presentation with Prezi

Prezi is an online tool which allows the user to create 
presentations. It is an alternative to slide-based tools 
like PowerPoint (Windows) and Keynote (Mac). The pe-
culiarity is: you draw your presentation on a single can-
vas, and you zoom in and out of parts of the canvas.

What do you need?

 Computer

 Internet access

 The Prezi site: 

https://prezi.com

Where to look for help?

 Prezi Knowledge base: 

https://support.prezi.com/hc/en-us

 The book Prezi For Dummies (2010) by Stephanie Di-
amond 

How do I prepare?

 A good way to begin is by preparing a few points of 
what you would like to cover in your presentation. 
You can also decide what supporting details you 
would like to put in your subtopics.

 It can be useful to sketch on paper the overall shape 
you want to create on the canvas and create a few 
sketches of specific elements within the canvas.

What do I do?

1) Create your account

Go to the Prezi website. Once there, click on the blue get 
started button. There are several options to pick from:

 Basic: This is the basic membership, and comes with 
a small amount of online storage. All presentations 
made with this membership are public and can be 
viewed by everyone. 

 Plus and Premium: for higher monthly fees, you get 
a numer of additional services, for example offline 
access to your presentations. When we last checked 

Fig 4.4 – Changing the background.

Fig. 4.5 – Show animations.
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in June 2019, prices were between 19 und 59 euros 
per month. – There is also an option for a free trial 
for two weeks.

 To make a new Prezi account, the website will ask 
for your name, e-mail address and a password. Once 
you have entered all your information, simply click 
on the Create your free Basic account button.

2) Making a presentation

a) Create 

 Once you are in the dashboard, click on the New 
presentation button to get started with making your 
new presentation. This button will take you to a new 
tab called the “Canvas” which is where you will edit 
your Prezi presentation. 

 It will prompt you to select a pre-made template by 
clicking on one of them and then clicking on the Use 
template button on the bottom.

 You can also start from an empty sheet of paper (in 
category “General”). Sometimes this is the better 

solution because you are more free to develop your 
ideas.

 Write a title of presentation and choose who can see 
this presentation. If you are using the free version 
you must choose: “anyone on the web”. 

b) Customize the theme 

 Change theme options to customize. You can choose 
a predesigned theme, change the background col-
our, or add a background image.

 From the editor, click the Background & Theme but-
ton in the context toolbar, or go to View > Show 
Background & Theme to get the pop-out sidebar.

(See Fig. 4.4)

c) Lay out your topics 

 To begin creating your presentation, click on the 
field that reads “Click to add text”. 

d) Add content

 Topics can also include subtopics that are revealed 
when you enter a topic so your content remains hid-
den until you’re ready to show it. You can fill subtop-
ics with text, images, video and more. 
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e) Adding and editing shapes

 To add a shape to your presentation go to the area 
where you’d like to add it. Go to Insert > Shape… 
from the top menu. Find the shape you would like 
to add in the sidebar and drag it on to your canvas.

 In the context toolbar you can adjust the colour, bor-
der colour, and border thickness. You can also select 
a present colour according to the theme of the tem-
plate.

f) Structure type

 You can freely place subtopics anywhere on your 
canvas. Select Subtopic and then click the Structure 
type” button in the context toolbar and select Per-
sonalized. If you want to move a subtopic simply 
click on it and drag it. The order subtopics appear 
when presenting is shown in the left sidebar.

g) Using animations

 In the editor, click on the animation icon in the con-
text toolbar or go to View > Animations to show the 
sidebar. Once you open the sidebar, you’ll see start 
and end points that show where the animations ap-
pear in your presentation. 

(See Fig. 4.5)

 Select the object or text and select the animation 
you’d like to add.

 Fade in and fade out. With Fade-in animation you 
control when the object or text appears or disap-
pears. You can fade in or out of images, text, video, 
topics, and subtopics.

 Add zoom area. Click Add zoom area and a rectangle 
will appear. Resize it and place it to fit the area you’d 
like to include in the zoom.

Fig. 4.6 – Start presentation. 
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h) Adding image, video, audio 

 Click on Insert at the top of the page. A drop down 
menu will appear that will allow you to add an im-
age, video, audio and much more. 

 To add a video, you paste the YouTube video URL 
(that’s its address in the internet) into the text field 
and click on the Insert button. The video will be add-
ed to your presentation. Or you can select a video 
from your files. 

3. Present

 For presenting your presentation to an audience, 
you click the Present button top right. Prezi will 
switch to presentation mode, usually in full screen. 

(See Fig. 4.6)

 Using the mouse, you can easily jump between 
slides. 

 Instead of displaying the presentation in a classroom 
through a project, you can also use the Prezi mobile 
app to show the presentation anywhere, whenever 
opportunity strikes.

4. Share 

 You can send a link to your colleagues. Anyone with 
link can view it but not edit it.

 Click on the Share button and give the link a name 
so that you later remember what it is for (what pres-
entation, to be shown to whom)

4.  The Blended Educator: Advanced Activities
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Teaching Benefits

 With Prezi you can focus on detail, but you can also 
see the big picture.

 It creates visual impact. With the zoom in/zoom out 
function, it brings your message to life. 

 Your audience can navigate the Prezi themselves, 
observe connections of ideas and get a visual im-
pression of concepts.

 If you already have all your notes in PowerPoint, you 
don’t need to start all over again. Use the Power-
Point Import feature to transfer your existing con-
tent directly into your Prezi.

Common Mistakes to Avoid

 Confusing transitions: Consider your transitions and 
make sure that you aren’t constantly moving from 
one corner of the presentation board to the other.

 Printing: Other than standard desktop presentations 
such as Powerpoint and Keynote, Prezi presenta-
tions are not printer friendly. If you need to hand out 

your slides be aware that this might present a bit of 
a road block.

 Presentations can fail at a crucial moment:  If you 
don’t have the Prezi desktop app, Prezi completely 
depends on your internet connection. But the desk-
top app is only available in paid subscription plans. 

Online or Offline?

 The default mode of using Prezi is in online mode. To 
show your presentation you go to your account on 
the Prezi site and click the blue “Present” button. For 
situations where you do not have access to the Inter-
net, there is the Prezi desktop app (paid subscription 
required).  

 If you and your learners have access to the internet, 
you can share it with them. A view link allows anyone 
with the link to view, but not edit, a presentation.

 Downloading a presentation is available for users 
with a paid subscription such as Prezi Plus.

 Exporting a presentation to PDF: also only for paying 
subscribers.

Blend-it-well Handbook 
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4.2  Podcasts

1 Linguists like calling this a portmanteau word, the notion going back to Lewis Carroll’s Through the Looking Glass.

A podcast is an audio recording mimicking a radio pro-
gramme, but usually distributed as a downloadable file 
via the internet. –  The term “Podcast” is a blending of 
two words1  with pod referring to portable audio devic-

es such as the iPod (which got its name because it re-
motely resembles a pod of peas), and broadcast relating 
to radio programmes.  

4.2.1  Podcasts –  How and Why 

What do you need?

 Pen and paper. Or perhaps you are used to take 
notes on your computer. Anyway, you need some-
thing to write with for planning and scripting.

 A device to record audio with good quality. You 
could use a voice recorder, but usually you would use 
a computer. Almost all mobile phones, laptops and 
tablets have recording software on them. However, 
important for good quality is a g  ood microphone. 
So, Podcasters usually use external microphones of 
better quality. Good USB microphones start current-
ly (2019) at around 60 euros. Standard advice is to 
purchase a dynamic microphone that is front-firing 
with good rejection, meaning it picks up your voice 
clearly without the unwanted sounds of wherever 
you are recording. That helps for example recording 
your voice but not the hum of your computer’s fan 
or noise from the street outside.  

 Of course, you theoretically can use any microphone, 
even the built-in one of your computer or mobile 
phone. But this will usually result in less enjoyable 
audio quality.

 Audio editing software, for example Audacity, which 
will be introduced in the next chapter in detail.

 An online platform to host your files. Or storage 
memory to save them, and give them to your audi-
ence.

Where to look for help?

 Simply look in the internet, using your preferred 
search engine, for terms like “Podcast tutorial”. This 
will get you to websites, videos etc. published by 
experienced podcasters. It would not make much 
sense to publish a selection here, as these things be-
come outdated quickly. 

 You will find good up-to-date podcasting tutorials 
on specialised websites that offer podcasting host-
ing, such as Podomatic, Soundcloud or Audioboom. 

 Be aware that many of those who publish tutorials 
for podcasting are actually trying to sell stuff, e.g. 
software, podcasting platforms (where you could 
publish your podcasts), or simply equipment like 
microphones. 

 But to start with, on the following pages of this book 
you will find introductions to two crucial topics:  au-
dio recording, and audio editing. 

Further reading

If you want to read more about the use of podcasts in 
education, try these research papers: 

 Andrea Chester, Andrew Buntine, Kathryn Ham-
mond and Lyn Atkinson: Podcasting in education: 
Student attitudes, Behaviour and Self-Efficacy. 

https://pdfs.semanticscholar.org/c5dd/a0851367ef6582fad-

42be08a2454ad9dd869.pdf 
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 Brandon I Collier-Reed, Jennifer M. Case and Angela 
Stott: The influence of podcasting on student learning: 
a case study across two courses. 

https://core.ac.uk/download/pdf/43958163.pdf 

What do I do?

Writing your script

For a start: think of a 5 minutes lecture to give to your 
students (learners, auditory). 

Usually you will need a written text which you then 
read / perform for the record. Experienced teachers and 
writers will be able to write their text right away. But for 
beginners it is better so develop a script step by step. 
Write down the key words you need to mention about 
your topic, and based on these words create some sen-
tences. Using those sentences and the content from the 
Template Script above, create a script that you can read 
for the podcast. 

Think also of reading your text together with a col-
league, in dialogue. This can be much more palatable 
for the audience. One of our colleagues produces a pod-
cast for learning French, and she regularly publishes in-
teresting dialogues in French where she debates issues 
of French language with her friend. 

If you want to create a 5 minutes podcast, that is usually 
somewhere between 500 and 750 words.

Record your audio 

 Rehearse reading the script a few times before re-
cording.

 Some of us prefer sitting down at a table when re-
cording, others like to do it standing. Just stay com-
fortable.

 Start the recording device and read the script. 

 If you make a mistake, just stop the recording, and 
take a breath and start again. If you keep making 
mistakes after 5 recordings, take a break, make your-
self a cup of tea and come back to it later. 

Publish your audio

 When you are happy with the recording, save that 
recording, e.g. as an mp3 file. 

 Publish your podcast on your preferred podcasting 
platform. –  Well, right. Where to publish podcasts, 
that’s an entire topic of its own. It is, unfortunately, 
not covered by this book.  

Teaching Benefits

 Podcasts allow for portability and convenience; 
learners can access learning resources anytime, an-
ywhere and anyhow, with very little effort. It only 
needs a mobile device.

 Podcasts can be listened to in otherwise wasted 
time, or alongside a routine activity (sitting on the 
bus, driving the car, washing the dishes or in the 
gym).

 Learners can be involved in the creation of podcasts, 
asking them to contribute with questions, discus-
sions, presentations or projects.

 Podcasts may consist in the simple recording of 
your lectures, allowing learners to review them or to 
make up for missed classes.

 Podcasts can be a great aid for learners with mental 
or visual impairments.

Common Mistakes to Avoid

Use of technolgoy

 Avoid poor recording quality, which might discour-
age learners to listen until the end of the podcast. 

 Try to place your microphone so it picks up a min-
imum of the room’s noise (including computer 
noise). Set up the microphone so that it is 4 to 6 
inches away from your mouth.

 Avoid poor recording quality, which might discour-
age learners to listen until the end of the podcast. 

 Try to place your microphone so it picks up a min-
imum of the room’s noise (including computer 
noise). Set up the microphone so that it is 4 to 6 
inches away from your mouth.

 Avoid rooms with a lot of echo from bare walls, ceil-
ings and floors. If necessary, cover parts of them with 
sheets of acoustic foam. Sometimes even a woollen 
blanket or curtains may help.
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Being a voice artist

 Don’t move too much. While talking, try to look only 
in one direction - moving your head left or right, up 
or down, while you’re talking will change the tonal 
quality of your voice, and may be distracting to your 
listeners. 

 Don’t speak in monotone with a flat voice. Stress 
meaningful parts and try to hold the attention of 
your audience.

 Speak in a normal, clear and conversational tone of 
voice.

 Be consistent in your speech and follow the logical 
progress of your arguments. 

 Avoid extensive vocal pauses.

 Don’t break your discourse with a large use of inter-
jections (uhm, ahem, etc.).

 While talking, speed and slow down at different mo-
ments. Find your own speech pace. 

 Follow your script. Improvisation doesn’t always 
pays off.

Online or offline?

To make your audio record (your podcast) available to 
your audience, you can do various things. 

 You can simply copy the file to a memory stick (or 
any other memory, even a CD) and hand it out to our 
audience. This is called “offline” distribution.

 If you and your learners have access to the internet, 
you have a lot of options to distribute your record-
ing to your learners. 

 You can share it with them using cloud storage (e.g. 
Dropbox, Google Drive, and AWS).

 You can email it to them

 If you have a website you can upload it there

 You can upload it to a Virtual Learning Environment 
(such as  Moodle, Blackboard, and Edmodo) if you 
have access to one. This could be the Moodle site of 
your adult education organisation. 

 You can add it to a dedicated podcasting site (e.g. 
Podomatic, Soundcloud or Audioboom). They usual-
ly provide a basic account for free, and ask for mon-
ey if you want more sophisticated features. 

 Some people publish their audio records also by 
uploading them as videos (with simply one picture 
added to it) on video sharing platforms such as You-
tube. 

4.2.2 Record Audio with Audacity 

Being able to edit audio recordings is an important skill 
for the blended educator. It is therefore a good idea to 
do even the initial recording with a suitable audio re-
cording device (as opposed to simply pressing the Re-
cord button of your smartphone’s audio recording app). 
Also, usually your audio will not perfect just from the 
initial recording. You will have to do some audio editing. 
We are considering here the use of Audacity, a free soft-
ware programme that allows us to do this.

What do you need?

 A script for your podcast. (See Chapter 4.2.1 Pod-
casts.) 

 Audio editing software, here specifically Audaci-
ty (www.audacityteam.org), and a device to run it. That’s 
usually your computer, plus ideally a good external 
microphone. 

 An online platform to host your files, or a storage 
memory to save it.

Where to look for help?

 The Audacity online guide:   

https://manual.audacityteam.org/quick_help.html  

 The Audacity tutorials:

 https://manual.audacityteam.org/man/tutorials.html 
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 Simply use an internet search engine and type e.g. 
“Audacity export mp3”. Audacity is a very popular 
programme, so people discuss questions they have 
about using it broadly.

How do I prepare?

 Go to the Audacity website and download the soft-
ware version compatible with your device (Win-
dows, Mac, or whatever).

 Install it. 

Here is a little obstacle: usually you will want to save 
your podcasts in the .mp3 audio file format. Audac-
ity can do this, but for reasons of patent law, the au-
dio encoding software for this format is not included 
in the installation package. You need to download 
and install it separately. The Audacity website will 
lead you through that process. 

 Be sure that audio on your computer is working 
properly, especially that there is a microphone, and 

that it is working. If not, you have to figure out how 
to solve the problem. 

 Usual things to do in case of problems are checking 
your computer’s sound control panel or the custom 
mixer application for your specific sound card. If you 
use an external microphone, sometimes you have to 
select it in the audio settings to make it work.  Se-
lect the input device you want to use and verify that 
you are getting sound into the computer from that 
device. 

What do I do? 

When Audacity is launched, you will see something like 
this:

(See Fig. 4.7)

First, pay attention to the Device Toolbar.

(See Fig. 4.8)

Fig. 4.7 – The Audacity screen on start of the programme, with not yet any tracks created. 

Fig. 4.8 – Audacity’s Device Toolbar. Settings here are crucial for getting the software working with your hardware.
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You see four dropdown fields. They allow you to select 
(from left to right) a) audio host b) recording device c) 
recording channels e) playback device.,

 Choose your preferred Audio Host from the drop-
down menu. The Audio Host is the software interface 
between Audacity and the physical sound device 
on your computer. The available choices will vary 
depending on the operating system and your hard-
ware.

 Choose your preferred recording device from the 
dropdown menu Recording Device. For recording 
podcast, you will simply choose your microphone. 
– Other choices would include loudspeaker. This 
means that the audio signal is taken from the input 
port of your loudspeakers. Or in other words: you re-
cord what your loudspeakers are currently playing.)

 In the Recording Channels dropdown menu you 
can choose whether you want to record in mono 
(1 channel) or stereo (2 channels). Usually when  re-
cording with one microphone you will want to re-
cord in mono.

 Turn on the monitoring: click on the microphone 
symbol in the recording meter and start monitoring 
your audio input. 

 Get your microphone in place and talk at a normal 
volume and watch the recording meter: 

Try to aim for a maximum peak of around -6 dB (or 
0.5 if you have your meter set to linear rather than 
dB). You can always increase the level later after you 
have completed your editing. But recording with 
too low a volume will increase the amount of back-
ground voice on your record, so avoid recording at 
low levels. 

 Adjust the recording volume with the Recording Vol-
ume Slider:

The meter should get close to the right-hand edge 
without hitting it during the loudest parts (-6 dB is 
a good target).

 Now you are ready to start with a test recording. 
Click the red Record button in the Transport Toolbar:

Try and record a few sentences, and then click on the 
Stop button.

Have a look at the recorded waveform. This is how a 
properly recorded waveform should look like:

This is in strongly zoomed-in view. The default view 
is more like this:

A clipping waveform, on the other side, has the tops 
and bottoms of the wave chopped off.

This is what happens when the volume of the source 
sent to Audacity is louder than what Audacity can 
record.

Checking the waveform of your record can help you 
create audio files with good quality. If clipping oc-
curred, turn down the recording level a bit and try 
again.

You can also check for clipping by clicking on View > 
Show Clipping. Audacity will display vertical red bars 
in the waveform wherever it detects clipping.

g
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 When you are done with your recording, there might 
be some bits at the beginning or end that you want 
to delete – between the time you clicked the Record 
button and the time you started talking. In that case, 
click repeatedly the Zoom in button until the dis-
played waveform expands so you can see from the 
beginning of the recording to the time you started 
talking. Select the area that you want to get rid of 
and choose Edit > Delete (or simply the Delete button 
of your keyboard).

 If you realise that the volume of your recording is not 
as loud as it needs to be, you can adjust this using 
the Normalize effect. Choose Select > All to select the 
entire track and then click on Effect > Normalize to 
normalise the volume.

 When you are happy with the final result, save your 
track by clicking on File > Save Project. Choose a 
name for your project and a place to save it.

 To export your audio file and listen to it in other au-
dio software, choose File > Export > Export Audio, se-
lecting your preferred file format (usually mp3).

 You can now use this file for publishing your pod-
cast.

Online or offline

(See the section at the end of Chapter 4.2.1 above.)

4.2.3  Editing Audio Records by Adding Other Audio 

Elements 

Audio recordings can be augmented with background 
music, ambient sound, audio effects etc. The final prod-
uct is sometimes called a “soundscape” (think of an 
acoustical landscape). For example, the intro, the outro  
and transitions can be highlighted with the use of audio 
pieces, making your whole podcast more attractive and 
engaging. You know this from radio programmes. 

In this chapter we introduce you to a number of things 
you can do in audio editing with Audacity.

What do you need?

 A script describing the interaction between oral 
texts and music pieces; or at least a good plan for 
this in your mind.

 A device to record audio with good quality (comput-
er, voice recorder, etc.)

 Audio editing software, here: Audacity

 Music or other audio files you want to mix with your 
voice; of course only such that you have to right to 
use for.  

Where to look for help?

 The Audacity online guide:

 https://manual.audacityteam.org/quick_help.html  

 The Audacity tutorials:

 https://manual.audacityteam.org/man/tutorials.html 

 Just do an internet search for topics you are inter-
ested in. Audacity is very popular, so there is a lot 
of help sites and forum discussions around using it.
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How do I prepare?

We assume here that you have already recorded your 
podcast text and saved it to an audio file. (See Chapter 
4.2.2 above) 

 Choose the music or sound effects you want to mix 
with your voice, and where to place them. 

For royalty free soundtracks you can check here: 

http://freemusicarchive.org/genre/Soundtrack/ 

 Check that the selected music or sounds effects are 
of good audio quality, making sure that they won’t 
sound bad on your recording.

What do I do?

Setting up the project:

 Start a new project in Audacity. In practical terms 
that means: open Audacity with a clean screen. 

 Import the background music file on your project. 
Click on File > Import > Audio… to choose the audio 
file you selected. This will appear as a stereo track on 
the Audacity screen. 

 Import your podcast record File > Import > Audio... 
This will become a second track on your Audacity 
screen. 

Or alternatively, if you haven’t yet recorded your 
own voice and rather want to talk and record while 
listening to the background music: first, make sure 
that the option Transport > Transport Options > Over-
dub (on/off) is checked; then, using headphones to 

Fig. 4.9 – Typical sight of an Audacity screen with a stereo track, a section of it marked (that’s the lighter area).
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listen to the background track, record your voice. 
The Overdub function makes sure that while record-
ing on a new track, you listen to the sound that is 
already there on other tracks.  

 Save everything as an Audacity project: File > Save 
Project As >  [Give it a name]. This creates a set of files 
(.aup) that allow for editing. 

Your screen will now look more or less like this:  
(See Fig. 4.9)

Editing the record:

 Click the Skip to Start button (to make sure you start 
from the beginning), then click the Play button. 

Note that Audacity automatically mixes the music 
and speech from the two tracks for you. Click the 
Stop button when you’re done. 

The Mute and Solo buttons of each track can be used 
to control which track will be heard when clicking on 
the Play button.

 In the record of your voice, you may want to remove 
some sections, e.g. where you coughed, cleared 
your throat or misspoke and started again. 

You do this by marking the section in question with 
the selection tool: 

With this as your mouse pointer, drag-select a sec-
tion of an audio track. A marked section of the audio 
appears in lighter grey (in older versions of Audacity 
it was darker grey) like here:

(See Fig. 4.10)

In the waveform above, the speaker wanted to cut 
a piece of recording where he/she paused, cleared 
his/her throat and continued with the next sen-
tence. To do so, the throat-clearing chunk has been 
selected (light grey area), with extra space around it 
to make the transition sound natural. 

To remove the selected area, use the Cut tool: 

Or simply press the Delete button on your keyboard. 

But before you do this, you perhaps want to check if 
the cut is well selected. You can do this using Cut Pre-

thththhe e e PlPlPlPPlllPPllllPPPPPlllPPllllllPPPPlllPPPPlllPPPllPPllllllllllllllllllayayayaaaaayayaaaaayaaaaayyaaaaaaayyaaaaaaaaaayyaaaaaaaaaayyayaaaaaaaayaaaayaayayyyyyyyyyyyyyyyyyyyyyy bbbututtttoton.nn.n.n.nyyyyy

Fig 4.10 – Marked sections have a different shade, here: lighter grey.

Fig 4.11 – A track with two split points. This splits the track in three parts that can be moved independently.
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view. Simply press “C” on your keyboard, and Audac-
ity will play the section as it would sound after cut-
ting. It starts playing about 2 seconds before the cut. 
That’s the Cut Preview feature. If you are happy with 
the cut, do the cut (Delete or Scissors). If not, adjust 
the selection, until you are happy with the result. 

 You can split your narration in different clips by 
choosing Edit > Clip Boundaries > Split. This will split 
the track either where you left the Select tool, or at 
both the beginning and the end of a selected area 
(dark grey, or light  grey). 

For example, the track below has two split points, 
resulting in three separate .

(See Fig. 4.11)

With the track split that way, you can now move the 
individual parts around (back and forth) on the time-
line. For doing this, use the Time Shift Tool.

 To let the talk start at a certain point of your back-
ground music: find the spots in the background mu-
sic where you want each of the different narration 
clips to start. You might even put a label on each 
section, to identify them best throughout your work.

(See Fig. 4.12)

Using the Time Shift Tool, drag the narration clips to 
line them up with the background music’s points 
where you want them to start.

 When you have the narration clips where you want 
them to be, lower the volume of the background 
music so your listeners can hear what you are say-
ing. You can do it manually by clicking on the 
Envelope Tool on the Tools Toolbar selecting two 
control points and then adjusting them to get the 
length of the track you want the fade to be effective. 
Go back and change the fades until you are happy 
with the result. 

Alternatively, you can use the Auto Duck effect which 
does¬ the same job automatically (Effects > Auto Duck). 
With Auto Duck you can pre-set a certain characteristic 
of transition, and then apply it to selected sections of 
a track. (But note that this needs a second track being 
there against which the reduction of volume will be 
measured.)

Fig. 4.12 – Use labels (bottom row) to mark spots on the timeline in order to find them quickly later.
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 If you want to fade out the music, first find the point 
where you want the effect to begin. Then choose Se-
lect > Region > Cursor to track end, than choose Effect 
> Fade Out.

 Check your waveform for possible clippings or bad 
signal.

 Use the Gain Slider left of your current track to set 
the gain for the track (thus correcting possible clip-
pings). “Gain” means effectively the strength of the 
signal. 

 Use the Pan Slider to balance the signal between 
right or left side of your speaker or earphone.

Gain and Pan sliders are underneath the Mute and 
Solo buttons. 

 Save and export the final version of your project. 
Saving means: you save Audacity’s .aup files. If you 
want to create a file that you can give others to listen 
(usually .mp3), you use File > Export.

Online or offline

(See that part of Chapter 4.2.1 Podcasts)
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4.3 Videos

1 These were the conditions when checked in April 2019. Of course they will change over time.

Videos can be useful in e-learning environments to add 
more of the human element of teaching. Videos –  as 
opposed to classroom presentations of content –  can 
help learners to control the pace of their learning. 

There are many kinds of videos for educational purpos-
es. A simple concept (but demanding in terms of equip-
ment) is video-recording a gifted teacher lecturing. Or 
you probably have seen full-sized educational films pre-
senting historical events and developments, explaining 
phenomena of physics or chemistry, mathematics, or 
whatever topic, often with a lot of special effects used 

to visualize things. Producing such videos is, of course, 
a lot of work. 

In this part of the book, we want to focus on something 
very simple, but effective: creating short animated vid-
eos that can be used to present some facts. We use an 
online service by the name of Powtoon. This allows us 
to create animated videos in cartoon style. The result is 
something like a beefed-up slides presentation: Power-
point with much more animation than usual, so to say. 

4.3.1 Creating Animated Videos with Powtoon

Powtoon (www.powtoon.com) allows you to create and pub-
lish animated videos in a relatively simple way as you do 
not need anything but internet access for your comput-
er. Everything is done online. 

Powtoon is a London based company founded in 2012. 

Here is a summary of what you do with Powtoon:  You 
create animated slide shows online. You add to your 
slides cartoon characters that can move; text elements; 
all kinds of drawings; you can use a repertoire of visual 
elements from Powtoon, or you can upload our own 
(images, drawing, videos), and add animated effects to 
them. You can add sound to your slideshow for creating 
a soundtrack with background music and with text spo-
ken (“voiceover”). The animated video can be watched 
on the Powtoon website; it can be exported to video 
places such as Youtube; or you can download it as a vid-
eo file and store it on your own device. 

The company running Powtoon advertises it chiefly 
for business communication. They suggest employees 
using animated slide shows to present information to 
superiors, or HR departments create health and safety 
instructions for employees. But it can also be used for 
creating e-learning content for Blended Learning.  

Basic functions are free. For more sophisticated options, 
however, including the option to download your video 
file, you would need to buy a subscription. Subscrip-
tions are currently (2019) sold from 228 dollars per year 
(including VAT) for the cheapest version.  There is no 
option to subscribe for a shorter period. There are, how-

ever, special “education” subscriptions that are cheaper, 
starting from 85 dollars per year for a “student” account 
(videos up to 10 minutes) and 228 dollars per year for 
full access to everything (for 90 students).1   

The Powtoon site (www.powtoon.com) has a number 
of sample videos, and a detailed help centre. As there 
are many functions, it would fill a book of its own to de-
scribe them all. What we can do here – in this collection 
of useful tools for creating content for Blended Learning 
in adult education – is give you the basic idea, and lead 
you through first steps. 

But be aware that creating such animated videos (or 
animated slideshows) that you can use in your Blend-
ed Learning environment, you will need to dive much 
deeper into the topic. You will need to learn to use the 
many options, and you will need to get a feeling for 
when to use ready-made elements (characters, draw-
ings, chiefly available for paying subscribers), and when 
to use elements you create and upload yourself. 

Another thing to be aware of: Powtoon is not the only 
company providing such services. One recent alterna-
tive is Doodly (www.doodly.com) which is for creating 
doodle videos. “Doodle videos” is a name for that fa-
mous type of videos where you see cartoon-style draw-
ings being created on the fly by a moving pencil, and 
sometimes a hand. 

In the future other such services will appear, and as we 
have seen old ones will disappear e.g the Google+ so-
cial media site has recently been discontinued (2019).  
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Now, here is our “First steps into Powtoon” tutorial: 

What do you need?

 A computer

 Internet access

 The Powtoon site: 

www.powtoon.com

Where to look for help? 

 The Powtoon Knowledge base:

 https://support.powtoon.com/en/

 Powtoon tutorials:

 www.powtoon.com/tutorials/

 A good book is Power Up Your PowToon Studio Project 
(2015) by Bruce Graham, Packt Publishing.

 Another good book is The Power of Cartoon Market-
ing (2013) by Ilya Spitalnik, CreateSpace Independ-
ent Publishing Platform.

How do I prepare?

 The first thing to do is develop a script, that’s the 
story you want to tell. This should include the text 
you need, and ideas about visualisation: what to 
show, and in what sequence. Ideally, your story has 
a dramaturgical curve, for example getting back at 
the very end to something that was introduced at 
the beginning. 

 If you want to create a 5 minutes video with some-
body talking, that is usually somewhere between 
500 and 750 words in the script.

What do I do? 

 Go to the Powtoon site

 Create an account (if you do not have one)

 Skip any initial screens

 Create a new slideshow by selecting a Blank Pow-
toon:

(Note: The appearance of buttons and all other ele-
ments shown here may be different when you visit the 
site. Websites are under constant reconstruction and 
re-design. Screenshots printed in a book like here get 
outdated quickly.)

 You will be presented with a number of themes:

(See Fig. 4.13, next page)

 Select one, and you will get to the main composition 
page:

 Powtoon uses a slide-based approach to videos. 
That means that the whole story is split over a num-
ber of basic pages (or slides). In traditional film, you 
would call this a scene.  You create and edit one slide 
at a time. Each slide is by default 10 seconds long, 
but you can change this from 1 to 20 seconds. 

 You see your stack of slides in a column at the left 
hand side of the main page (quite similar as in Pow-
erpoint).
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 At the bottom of the main page you see the timeline 
for the current slide.

 (See Fig. 4.14)

 If you want to increase the time a slide is displayed 
you can do this using the + and - buttons on the 
right. A slide can last between 1 seconds to 20 sec-
onds:

(See Fig. 4.15)

The dark triangle indicates the timeline position of 
what is displayed at the moment.

 To add content to the slides, you use the control tabs 
on the right 

(See Fig. 4.16)

 First select a background:

You add  elements to your slide simply by clicking on 
them in the right column. The element then appears 
in the middle of your slide, and you can move, resize 
it or otherwise edit it.

 Next you can add in some text:

 When you added a text element, look down at the 
timeline: a tab has appeared at Second 1 with the 
first letters of your text, here “TEX”. This means the 
slide will display for one second blank, after which 
the text will appear. You can change the moment for 
the text element to appear by moving its tab to any 
position along the timeline.

(See Fig. 4.17)

 Next you might want to add “characters”. 

“Characters” are cartoon figures readily available 
for you to use. Each character is provided in various 
moods or activities (called “poses”), such as a greet-
ing, typing at a writing desk, thinking, being happy, 
being angry, or having an idea. 

Powtoon offers various sets of characters. Only two 
or three of them are free. The others are available 
only when you are a paying customer (subscriber).

Fig. 4.13 – Themes for animated videos as available on Powtoon in April 2019 (free account).

Fig. 4.14 – Timeline of the Powtoon video.

Fig. 4.15 – Increase the time a slide is presented with the +/- buttons right hand side.
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Fig. 4.19 – Adding a character into the current slide. 

Fig. 4.17 – A text element inserted at Second 1 of the Timeline.
Fig. 4.21 – Adding sound clips.

Fig. 4.20 –  Move the appearing of the new object (here: a character) on the timeline. 
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  Select from the menu of characters:

(See Fig. 4.18, this page)

 Select a character, and add them into the current 
slide:

(See Fig. 4.19, previous page)

 We see that the character will appear 2 seconds into 
the timeline.  We can change this by moving the tab:

(See Fig. 4.20, previous page)

 We also note that each character has four controls 
associated with it (Settings, Pose, Swap, and Flip):

With these you can swap a character with another 
(by keeping the other settings); select its different 
poses; flip it; control a number of other settings, for 
example how it moves. 

 Adding in Shapes works the same way:

                                            

Shapes are things like squares, triangles and circles. 
Props are drawings of various objects – everything 
that exists in the world, from cars over machines, 
clothing, furniture, and so on. Props are the requi-
sites of your tiny video theatre. As always: only a very 
small selection are available for free, for the rest you 
need a paid subscription. 

 Adding in sound works as follows:

(See Fig. 4.21, previous page)

You can add voiceover (spoken text). You can record 
this yourself, or you can upload a ready-made record.

 You can add Media (Videos and Images) and Special 
features. Special features are drawings for various 
events such as Birthdays, Christmas, etc. 

        

Multiple slides make a movie 

 So far you have worked only on one slide, or one 
“scene” of your animated video. A typical animated 
video of 2 minutes would have about 12 or more 
slides. You have to create all of them. You see: this 
can be rather time-consuming. You will be doing 
this especially when you know that you have a large 
audience and can use the video over a longer period 
of time. 

 What we explained here is how to create a an ani-
mated video starting with a blank slide (or stack of 
slides). Powtoon offers also something else: they 
have a number of ready-made animated videos that 
can be used as templates that you fill with your own 
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content, particularly by leaving the story flow as it is, 
but change the text (written and spoken words).  For 
testing we created this video.

You can watch it at:

www.youtube.com/watch?v=zYDYuVekfJI

As you can see in this video, one problem of those 
pre-fabricated video templates can be their shal-
lowness and their sales- and marketing focus. Adult 
educators usually seek more substance, and that 
would mean that the templates cannot be used as 
they are but need heavy editing. The good news is: 
this is possible. Although it is a lot of work. 

Download or share

 Once you are happy with the completed project, by 
clicking on the Preview and Export button on the top 
of the page, you can upload, download or share the 
project (options vary with subscriptions):

(See Fig. 4.22)

Teaching Benefits

 There can be great novelty and thus motivation in 
using animated videos.

 Sometimes when dealing with sensitive issues like 
plagiarism or bullying, it can be better having ani-
mated characters discussing it rather than real peo-
ple.

 When explaining intangible concepts, like magnet-
ic fields, animation can give the learners a concrete 
conceptualisation. 

 Animated videos can appeal to a wide range of 
learners.

Common Mistakes to Avoid

 As you create each slide, always ask yourself, what 
are the educational value of each of the element in 
the slide. It is very easy to add a wide range of effects, 
but they must have a purpose to help the learners 
learn, so don’t add special effects unnecessarily.

 In a related piece of advice, there is no need to clut-
ter a slide with too much content, since Powtoon is 
a slide-based system, you can break content over a 
number of slides.

 When you are doing your recording, speak with pas-
sion and don’t be too deadpan.

 Maintain continuity between slides by using the 
same fonts and design elements. But don’t use the 
same graphics to represent different things on dif-
ferent slides.

 Avoid using fancy transitions between slides.

 Read one of Edward Tufte’s books.

Fig 4.22 – Various options for sharing the video, download it, and export it.
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Online or Offline?

 If you want to distribute this recording offline, you 
can copy the video file onto a USB memory stick and 
hand it out in class. However: for downloading the 
video you need a paid subscription. 

 If you and your learners have access to the internet, 
you have a lot of options to distribute the video to 
your learners. Except from sharing the video file with 
them via e-mail or file sharing services, you can pres-
ent the video on your website etc. Powtoon also of-
fers direct publishing on major video platforms such 
as Youtube, Vimeo and others. 
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4.3.2  Making Videos Interactive Through Add-on 

Quizzes

1 Information as publicly available in April 2019.

There are a number of ways to add quiz questions to 
pre-existing videos. Here we present one of them: Ed-
puzzle. 

The Edpuzzle website allows you to add questions to 
existing videos at any point of their timeline. It also al-
lows you to edit existing videos to some extent, e.g. by 
cropping or adding content. In this short introduction, 
however, we use it only for adding quiz questions to vid-
eos. 

Edpuzzle is run by a company with its headquarters in 
Barcelona, Spain. Registered in 2014, it is a typical start-
up company supported by business angel and venture 
capitalist money. 1

When we last checked (in April 2019) the pricing mod-
el was as follows: the service is free of charge, but with 
the restriction that only up to 20 videos can be stored 
in one’s space. If you need more, you can try to invite 
friends to subscribe to Edpuzzle, and consequently you 
get more storage. Or you subscribe to the paid service, 
starting at 8,50 dollars per month. And this time the 
pricing is really on a monthly basis, meaning that other 
than for other web services discussed  in this book you 
indeed can subscribe only for a short time, for thorough 
testing.  

What do you need?

 A computer

 Internet access

 The edpuzzle site: https://edpuzzle.com/

Where to look for help?

 The edpuzzle help centre: 

https://support.edpuzzle.com/hc/en-us

 Edpuzzle resources: 

https://go.edpuzzle.com/resources/

 Edpuzzle on twitter: 

https://twitter.com/edpuzzle

How do I prepare?

 The first thing to do is to locate a video that you 
want to add quiz questions to. “Locating” means: 
make sure it is available somewhere on the typical 
video places in the internet such as Youtube, Vimeo, 
etc. That means: you can use practically every video 
that is out there in the internet. For example, if you 
want to teach maths, you can use the fantastic vid-
eos of the Numberphile series in Youtube, and add 
quiz questions to them. Or of course you can upload 
your own education videos to one of the platforms, 
and then tell Edpuzzle to use that. The important 
thing to understand here is simply that you do not 
upload videos to Edpuzzle. You tell Edpuzzle to use a 
video from one of the popular channels. 

 Watch the video, and identify what parts of the vid-
eo you want to create quiz questions for.

 Create the quiz questions –  so far just as a script for 
yourself.  

What do I do?

 Go to the Edpuzzle site

 Click on Sign up 

 Sign up as a teacher

 Add yourself to an existing or new school.

 You will be presented with a search window:
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Search for the title of the video you wish to add 
questions to. As explained above, Edpuzzle can take 
any video that is somewhere on the popular video 
platforms in the inter

In the left column of your screen there are places to 
select from:

 After selecting the channel (Youtube etc) search for 
your video by entering appropriate search terms in 
the search bar.

 When you have found it, put your mouse pointer on 
the video. Three icons will appear:

 You can now add this video to your personal collec-
tion of videos by clicking the Copy button. 

 Go then to My content (menu item in the left column) 
to get your personal collection of videos displayed.

 Select the Edit icon, and you’ll have the options to 
crop the video, add voiceover, add audio notes, or 
add a quiz:

 Select  Quizzes and you’ll be presented with the vid-
eo, with a progress bar, with a pointer with a green 
box containing a question mark (?): 

Play the video to the point you want to add a ques-
tion in, pause the video, and click on the green ques-
tion mark underneath the timeline.

 A small window will appear to the right of the video:

Using the three green buttons, you can create either 
an open-ended question, a multi-choice question, 
or simply add a comment.

You then continue playing the video until you reach 
the next point on the timeline where you want to 
interrupt the video for a question or comment.  

 Once you have completed your edits, click Save, 
then Finish.

 Now you have two options: either assign the video 
quiz to a class, or create a public link.
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 To Assign to a class you need to create a new class:

 By selecting Public links you can get a URL or an Em-
bed code:

You can give your learners that link, or you embed 
the video quiz in your website, e.g. your Moodle 
learning environment. 

1 Szpunar, K.K., Khan, N.Y., Schacter, D.L. (2013): Interpolated Memory Tests Reduce Mind Wandering and Improve Learning of Online 
Lectures. Proceedings of the National Academy of Sciences, 110(16), 6313-6317.

An experimental video with quiz

Here is a video with quizzes that we created whilst 
proofreading this book:  

https://edpuzzle.com/media/5ca751dc7270df407df877e4

Teaching Benefits

 Video quizzes  can be a great novelty and thus a 
great motivator1 

 They help learners remember key points in the vid-
eos

 They can help the learners to self-assess their pro-
gress

 They increase the interactivity of the blended con-
tent

 They can lead to learners taking active ownership of 
their learning

Admittedly, this is all quite oriented to a school-type 
learning environment, or possibly to vocational training 
in a company. In classical liberal adult education, where 
direct interaction between people is as valued as build-
ing upon their rich life experience, and where topics of-
ten are more complex and philosophical, opportunities 
to use such simple quizzes are restricted. But if you think 
of learning foreign languages, video quizzes can indeed 
be a nice add-on teaching and learning element. So, as 
always, everything depends on finding the right place 
for the right tool.  
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Common Mistakes to Avoid

 Try to make sure the questions are phrased as clear-
ly, and as simply, as possible. Consider piloting the 
questions on a test group. 

 Don’t add too many questions to the video. It will 
make the learners feel that they are being over-test-
ed.

 Review each question: is there a strong reason to 
add it to the video? Could it be merged with another 
question? 

 Try to avoid “negative” questions, as they can be con-
fusing, e.g. Avoid “Which of the following are not …”. 
Instead, try to have questions that ask “Which of the 
following are…”

 Consider using fun alternative answers in the ques-
tions

 Read Oppenheim’s book Questionnaire Design.1

Online or Offline?

You need to be online to use Edpuzzle

1 Abraham Naftali Oppenheim: Questionnaire Design, Interviewing and Attitude Measurement. First issued 1966
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4.4  Documents

A vital part of Blended Learning is providing content to 
learners that they can interact with at their own pace. 
One thing in common use are simple documents deliv-
ered in file formats such as Odt, Docx, or Pdf, which have 
become a world-wide quasi standard. They can be seen 

as electronic representations of an actual piece of print-
ed paper. But there are ways to  make such documents 
interactive and thus more engaging for the learners.

4.4.1  Creating Interactive PDF Content

Documents such as reports, articles, or e-magazines of-
ten come as PDF files (Portable Document Format). This 
is a file format initially created to get documents into a 
printing press whilst being sure that formatting is me-
ticulously preserved across platforms, i.e. on all different 
computer systems. But in the recent 20 years, PDFs have 
also become a standard for distributing documents of 
high visual quality to everybody. 

Typically such documents are not meant to be editable 
by the reader. However, today it is possible to create 
PDFs that comprise plenty of tricks and multimedia con-
tent to make them interactive documents – behaving 
not much different from a website. 

For example, you can 

 add links 

 add entire menus from where the reader can select 
where to go next 

 add audio or video files and let your reader view 
them without leaving the document

 add quiz elements, etc. 

These all are elements you probably know from web-
sites. In an interactive PDF, all these things are includ-
ed in the document. The document can be delivered to 
other people the usual way (e.g. via e-mail). It will dis-
play these functions when opened with Acrobat Reader 
or another suitable PDF reader software. These are usu-
ally available for free. 

What do I need?

 Computer or laptop (of course)

 PDF reader software, for example the free Adobe Ac-
robat Reader 

 A programme to create interactive PDFs. We recom-
mend here Adobe InDesign. That’s what this section 
is about. InDesign has become the industry stand-
ard application to prepare professionally printable 
documents. This is actually an expensive applica-
tion. But you can install it and use it for seven days 
free of charge, for testing. Adobe also has rebates for 
educational institutions.

Note that there are also other ways to create inter-
active PDFs. Very basic things such as hyperlinks 
to external resources can be done in text process-
ing software (MS Word, etc.) and then exported to 
PDF. For more options, using Adobe Acrobat Pro was 
standard over a long time, especially with the “PDF 
form” functions.

Where to look for help?

You will definitely need more help than this book can 
offer you. Adobe InDesign is a complex product. If you 
are so far only familiar with Microsoft products, the way 
organisational layout in Adobe products may be diffi-
cult to grasp (briefly: “palettes” instead of “menus”), and 
you need some time to get used to it. InDesign also has 
a lot of functionalities, and you will need guidance in 
order to find your way through them. Finally if you have 
an older product version, you may run into considerable 
differences as compared to functionality in the newer 
versions. Here are some places to look for help:

 The Adobe help centre (online) gives useful tips on 
how to get started, tutorials to expand your skills 
and step-by-step instructions. You can also see fre-
quently answered questions and forum discussions 
for solving problems. 

https://helpx.adobe.com/gr_en/support/indesign.html 
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 There are many websites providing advice on how 
to create interactive content: 

 Create PDF button tips: 

https://indesignsecrets.com/pdf-button-tips-tricks-and-problem-

solving.php 

 Create an Interactive PDF form from a word docu-
ment: 

https://theblog.adobe.com/create-an-interactive-pdf-form-from-a-

word-document/   

 Note however that this then involves the use of Ado-
be Acrobat (full version, not the reader), another 
piece of pricy software that is good to have, but not 
accessible to everyone. 

 A nice blog that provides instructions for first steps 
with Adobe InDesign: 

https://mariahalthoff.com/blogposts/create-interactive-pdf-indesign

How do I prepare?

We do not have the space here to explain how to use 
use InDesign for total beginners. Adobe programmes 
work in different fashion to Microsoft or OpenOffice. 
In what follows we presuppose that you have already 
some experience with InDesign e.g. because you used it 
to create leaflets, posters, or a brochure.

 Design your pages in InDesign as you would normal-
ly do. Your document needs to be (almost) finished 
before you start adding interactivity into it.

 Decide which kind of interactivity you would like to 
add. 

The field of expertise you might want to explore 
here is called Instructional Design. It can help you 
on where it is useful to include interactive objects in 
order to not overdo it with them. 

For a start read the Golden Principles of High-Quality Instruc-

tional Design to find out more.1  

 Prepare yourself for engaging interactive content: 

 Identify your target audience and their needs

1 This is a commercial website selling a tool for creating e-learning courses. They have, however, also a good collection of brief 
instructions and tips. - Website checked last in April 2019.

2 That’s if you use a newer version of InDesign. If you happen to have an older version (such as CS3), you do not have these 
workspaces. But the palettes you need are available there as well: Windows � Interactive � Bookmarks/Hyperlinks/States. You 
will not have some of the more fancy things such as page transitions.

 Use marketing psychology to trigger their cu-
riosity

 Use your creativity to make your content fun

 Combine data with visual content

 Invite your learners to participate

 Last and most importantly: personalize your 
content.

What do I do?

 Open your InDesign file and select the Interactive for 
PDF workspace.2

This will display a set of panels on the right side of 
the screen. Panels (or palettes) in Adobe products 
are like menus in other software: collections of tools 
to use. Here you get the following:

(See fig. 4.23)

You can now do various things to make your Pdf 
document interactive. Let’s start with creating hy-
perlinks.
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1) Adding hyperlinks 

As in websites, hyperlinks let the reader quickly jump to 
some place, e.g. a different page, an external website, 
a file stored on the same computer, etc. These are the 
types of hyperlinks InDesign currently offers: 

This is the Hyperlinks palette (here already filled with 
various hyperlinks). Most functions you will need are 
hidden behind the small Menu icon in the top right.

1 Alternatively, there is the Create New Hyperlink icon on the bottom oft the palette, shaped like a tiny piece of paper. As in all 
palette in Adobe software, this is to create a new item (specific for the type of palette).

a) Hyperlinks to jump to a different page

Let’s start with a very simply one: jumping to a different 
page. 

 Select any element in your document, for example a 
line of text saying “Got to Page 5”. 

 Open the New Hyperlink dialogue. – To do this, in the 
Hyperlinks palette click the Menu icon, then select 
New Hyperlink.1  

This is the New Hyperlink dialogue:   

 Give it the desired settings, here especially: what 
page to go to. The other settings are optional. You 
can play around with it to find out what they do. 

 Hit OK to save your settings. 

 The Hyperlink palette will now display your freshly 
created link:

b) Hyperlinks to jump to any piece of text 

Sometimes you want to send the reader not only to a 
different page in your document but to a more specific 
section of text. Here is how you do this. 

Blend-it-well Handbook 

Fig. 4.23 – Collection of 
panels (palettes)  under the 
“Interactive pdf” workspace 
environment.  
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 First you should set a text anchor. That’s a hidden 
mark in InDesign that you can attach to any piece of 
text. Setting such a text anchor is easy, but the func-
tion to do it is hidden away a bit. Do the following: 
1) Mark a piece of text in your document. 2) In the 
Hyperlinks palette, select from the menu: New Hyper-
link Destination. Under Type, the option Text Anchor 
should be preselected; if not, select it. (Alternatives 
are URL or Page). 4. Click OK. That’s it.

Fig. – New Hyperlink Destination dialogue, for 
setting text anchors.

 Now you can set a hyperlink pointing to that text 
anchor.

On any page of your document, select any element 
(a text, box shape, whatever) which you want to 
carry the hyperlink. On the Hyperlinks panel, in the 
menu, click New Hyperlink to open the New Hyper-
link dialogue you already know. Under Link to select 
Text Anchor, then under Destination select the text 
anchor you previously created. Click OK. 

(Fig. 4.24 – The New Hyperlink dialogue with settings for 
creating a link to a text anchor. Existing text anchors can be 
selected from the Text Anchor dropdown. Here a text anchor 
“That’s my piece of text” has been selected.)  

1 If you have programmed website, you know what this is. – The last version we tested was InDesign CC 2018, Version 13.1. 

2 Thanks for this tip to Keith Gilbert, https://indesignsecrets.com/creating-relative-hyperlinks-in-indesign.php. We checked his method, and found 
it working in Indesign CC 2018 (Version 13.1)

c) Further types of hyperlinks 

Further types of links you can use:  

 To create a link to a web page (URL), simply select 
URL instead of Text Anchor, and fill in the URL.

 Link to create an e-mail including the address and 
a pre-defined subject line. – This can be useful if e.g. 
you want your learners send you an email, e.g. for 
submitting homework. This, of course, requires that 
they have some e-mail software installed on their 
computer, for example Thunderbird or MS Outlook. 
In standard office environments, this will be the case 
most probably. But already now (2019) many, espe-
cially younger, people write e-mails only via online 
services (Gmail and so on), and with those this func-
tion might not work. 

 A hyperlink to a file will open a different file, for ex-
ample another PDF, or a DOCX, or XLSX. 

Standard procedure to create such a link to open a 
file: In the New Hyperlink dialogue box, under Link to 
click on File. If you have a path, type the pathname; 
otherwise click on the Folder button and locate the 
file on your computer system (or computer network, 
see below). Remember to click OK to save your ac-
tions.

For such links to work, the precondition is that this 
file is available on your learner’s computer. This un-
fortunately is a more problematic issue than you 
would think. If all of your students are in one large 
shared (company) computer network, you are okay, 
because they typically can all access the same folder 
on your network. But as you are an adult educator, it 
is more likely your students use their own comput-
ers. So, what you can do is send them the interactive 
PDF together with the accompanying files and ask 
them to store them in one and the same folder. But: 
InDesign‘s file links cannot be set to be relative, they 
are always absolute.1 That means you cannot just 
save the PDF and the other files in some folder and 
expect that everything works fine.  

There is one workaround though: if you do not use 
the ordinary Hyperlink - File method, but instead cre-
ate a Button (see below) and assign to it a File Open 
action, the link to the folder will be relative (although 
it is still displayed as absolute).2    
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For more on hyperlinks, the Adobe online help may be 
a good place to search: https://helpx.adobe.com/indesign/using/

hyperlinks.html

2) Adding bookmarks

A very good service to your readers is adding bookmarks 
to you document. This helps readers navigate through 
your document quickly and precisely. Bookmarks are an 
extremely useful feature in PDF documents, especially 
in cases with larger numbers of pages. Strangely, not 
many people seem to know about them or use them 
actively. 

Below you see how a PDF with bookmarks looks when 
opened in Acrobat Pro or Acrobat Reader, and with the 
Bookmarks pane switched on (left hand side):

(See Fig. 4.25)

For creating bookmarks in InDesign, you use the Book-
marks palette:

(Fig. – The Bookmarks palette provides you with the tools needed 
to create a set of bookmarks for readers to quickly navigate 
through your document. Here it is empty since no bookmark has 
yet been created.) 

Bookmarks can refer to either an entire page, or to a 
specific element on a page. If you want a bookmark to 
refer to a page, simply put the cursor on that page, then 
click the Create new bookmark icon on the palette (high-
lighted in the bottom area of the palette seen above). – 
If you want the bookmark to refer to a specific element 
on the page (a headline, a paragraph, a word), first mark 
that element, then click Create new bookmark. 

As bookmarks can be nested, you should pay atten-
tion to which existing bookmark is highlighted in the 
Bookmarks palette when you click Create new bookmark. 
In case a bookmark is highlighted, the new bookmark 
will be created as a subordinate (child) to it. If nothing 
is selected, the new bookmark will simply be added at 
the end. Eventually you will see a tree-like structure like 
here: 

(See Fig. 4.26)

You can also manually rename, delete, arrange, group 
or nest a list of bookmarks. Nesting is used to show a 
connection between topics.

Blend-it-well Handbook 

Fig. 4.25 – A bookmarked PDF, with the bookmarks displayed in the special  Bookmarks column left hand side in 
Adobe Acrobat. Note that bookmarks can be nested. 
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3) Adding action buttons 

Adding action buttons to a PDF document is an idea 
that obviously came from the world of websites. In web-
sites, buttons are used to offer users the option to select 
a topic, do the next step in a procedure, etc. 

Buttons are not totally different from hyperlinks, but 
they are distinguished through their visual appearance: 
usually like physical buttons on a machine (although in 
recent years with the emergence of “flat design” the old-
styled pseudo-three-dimensional buttons have widely 
disappeared). You can use such buttons also in your in-
teractive PDF. 

To create buttons, open the Buttons and Forms palette. 

(See Fig. 4.27)

In your document, select any element you want, for ex-
ample a shape or a text box. Then, click on the Convert to 
button icon (footer area of the panel). Finally, click the ‘+’ 
sign next to Actions to select the required action. Click 
Event to select how the button is activated and how it 
will act. A whole host of Actions are available:

1 Unfortunately, the Go to Page function where you can set the page number to go to manually does not work in interactive 
PDFs. (We tested in InDesign CC 2018, Version 13.1) 

(See Fig. 4.28)

We cannot explain all these actions here. Most of them 
are largely self-explanatory. We recommend trying 
some of these options out to get a feeling for what you 
can do with them. 

A very simple thing would be to use a button to jump to 
a different page (Go to First Page, Go to Next Page, Go to 
Previous Page, and so on).1  Or use a button to link to a 
certain website that your learners should visit. Also pay 
attention to the Open File action we mentioned already 
above, because this offers a (secret) way to use relative 
file paths that otherwise are not supported. 

Now, creating buttons yourself is quite a bit of work. You 
have to mind a lot of settings for their behaviour, and 
you have to invest time and energy into graphic design. 
Here is a typical Button and Forms palette with settings 
for buttons with different visual appearance depending 
on where is the mouse pointer.

(See Fig. 4.29)

One thing to help you saving time for creating graphic 
design for your buttons: In the Buttons and Forms pal-

Fig. 4.26 - Bookmarks palette with a number 
of bookmarks created. Two of them have 
bookmarks nested in them.  

Fig. 4.27 – The Buttons and Forms palette, 
here with the Types dropdown opened to 
select various types of elements such as 
buttons, check boxes etc.  

Fig. 4.28 – Quite a number of 
“actions” can be assigned to buttons. 

.
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ette, from the menu, choose Sample Buttons and Forms, 
to get a selection of pre-formatted elements that you 
can use: 

(See Fig. 4.30)

For more on buttons in InDesign: 

 General introduction to interactive pdfs: 

https://helpx.adobe.com/indesign/using/interactivity-5.html

 Nice and easy introduction into using buttons:

 https://www.youtube.com/watch?v=SikuzxPwufM

 First steps into the more complicated stuff: use but-
tons to make things appear and disappear on your 
pages with buttons: 

https://indesignsecrets.com/showing-and-hiding-objects-in-interac-

tive-pdf.php

4) Adding sound and videos clips

Making audio and video material accessible directly in 
your interactive PDF can improve the learners’ experi-
ence considerably. One click in the PDF, and they will 
hear you talking or see you dancing (or whatever au-
dio-visual material you include). 

The downside is that such files – especially videos – of-
ten take a lot of space, and thus your PDF can become so 
large that you cannot reasonably ship it to your learners. 
Or you have first to create sufficiently small video files.

Anyway, here is, in brief, how you add audio-visual me-
dia files do your PDF. It is surprisingly simple:  

 Click File > Place, select the file and position it in your 
PDF. 

 A resizable media object appears, linking to the me-
dia file. 

 See below for how audio and video files appear in 
InDesign.

(See Fig. 4.33)

 There are various settings you can make, e.g. change 
the audio icon, change the picture for the video, 
determine if these clips play automatically or only 
when the reader clicks them, and so on. All these 
settings are accessible in the Media palette.

(See Fig. 4.31)

 If you want to change the video or audio file, use the 
Links palette. 

Fig. 4.29 – Buttons and Forms palette, filled in with various settings for a typical 
button. You can set different visual appearance for the button depending on 
what the mouse does, but doing this well needs a lot of attention to graphic-
design.  

Fig. 4.30 – Ready-made buttons and other elements.  
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 Instead of including the video file into the PDF, you 
can also reference it to a file that sits somewhere on 
a server on the internet. Do this by first creating an 
empty frame in your document, then in the Media 
palette menu, click Video from URL. But note that this 
needs a real file sitting on that URL. A Youtube link 
does not work. A practical scenario is that you store 
your video files on your organisation’s server. This al-
lows you to display larger videos without pumping 
up your PDF file size too much. 

More about video and audio in PDF documents: 

https://helpx.adobe.com/indesign/using/movies-sounds.html

5) Page transition effects 

Page transitions can decorate your content when turn-
ing the page. They are those optical effects you proba-
bly know from presentation tools such as PowerPoint: 
pages move away, dissolve, pop up etc. Such visual ef-
fects don’t contribute much to the didactical value of 
your material, but used in healthy doses they can make 
a document look a bit more “professional”.  InDesign 
provides a number of effects. You can add different tran-
sitions to different pages or one transitions to all. This is 
what is offered currently (2018):

(See Fig. 4.32)

To apply page transition effects: 

 On the Pages panel and select the spreads (or pages) 
that you want to add transition to. 

 Then use the Page Transitions palette (if not visible, 
choose Window > Interactive > Page Transitions) and 
choose from the Transition dropdown the one that is 
most suitable. 

Fig. 4.31 – The Media palette offers a 
number of settings for the appearance of 
the element in the PDF document, and for 
its behaviour. 

Fig. 4.32 – The various options 
for page transitions, here from 
InDesign CC 2018. In earlier 
versions the selection may be 
slightly different. This list is in 
the Transition dropdown on 
the Page Transitions palette.  

Fig. 4.33 – That’s how audio (above) and video 
(below) files typically appear in the InDesign file: A 
loudspeaker icon for audio, a picture from the video 
clip, both with tiny symbols for audio and video top 
left. 
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Fig. 4.33 – The Page Transitions palette let’s you select and 
fine-tune a transition effect for one or multiple pages. Mouse 
pointer over the little image shows the animation that will be 
produced.

 You can customize the effects a bit via the Direction 
and Speed dropdown fields. 

6) Other elements for interactive 

PDFs 

There are many more options for interactivity in PDF 
documents. You can add checklists, checkboxes, fillable 
forms with text or signature fields, or cross-references.

Before you start, take some time to navigate through 
the tool and discover their features. Here are some use-
ful notes: 

 In InDesign you may see an option to include ani-
mations (palette: Animation), that make elements 
(shapes, text elements, etc.) move and change their 
shape similar to an animated movie. However, this 
does not work for PDFs. To use this, you would need 
to create Flash files (Shockwave Flash, SWF), which 
is a form of video that does not work across all plat-
forms. 

For more on this, see 

https://helpx.adobe.com/indesign/using/animation.html 

 It is possible to create entire quizzes, or sequences 
of elements that appear on a page step by step. But 
this needs a lot of settings to be done in the Buttons 
and Forms palette. 

 A good introduction is here:

https://indesignsecrets.com/showing-and-hiding-objects-in-interac-

tive-pdf.php

 More on check boxes: 

https://www.webucator.com/how-to/how-create-check-box-form-

field-adobe-indesign.cfm

Fig. 4.35 –  The Export to Interactive PDF dialogue offers a number of settings you may want 
pay attention to. Here from InDesign CC 2018 (Windows). 

Blend-it-well Handbook 
4.4.1  Creating Interactive PDF Content

4



103

 A short video introduction of good quality about 
working with form elements: 

https://www.youtube.com/watch?v=TtCpu_XUJFo 

7) Exporting your work to PDF

So far you have created various interactive elements, 
but you have not seen them in action. To do so, you 
have to create the actual PDF document. This is called 
“exporting”. You will do this repeatedly during your 
work on this document, because there is no other real-
ly working way to check if the interactive elements do 
exactly what you want. So it is a process of export, test, 
redo, export, test, redo... 

Luckily, exporting is simple. Click File > Export > Adobe 
PDF (Interactive) > Save, and you are done. Mind that 
“interactive PDF” must be selected. Otherwise you get a 
normal PDF document without interactive features. 

(Fig. 4.34 – Setting “Adobe PDF (Interactive)” during export is 
crucial.) 

You may also want to pay attention to the various set-
tings in the export dialogue that will pop up:

(See Fig. 4.35, previous page)

Note that in earlier versions of Adobe InDesign (which 
you may still use), the export procedure was a bit dif-
ferent. There, you had to explicitly tick a set of options 
in the Export dialogue to include interactive behaviour. 
Just check your version of InDesign. 

Teaching Benefits

PDF is a very popular format of documents used across 
the web, especially in professional publishing. Its large 
advantage is that is can be used across platforms with 
documents remaining consistent in design and func-
tionality. For teachers or learning facilitators, being able 
to create PDFs is therefore an important skill. 

Here are some more benefits of interactive PDFs:

 When using interactive PDFs as teaching aids, your 
learners do not need additional resources (except 
a computer, obviously). Your learners can respond 

and interact, as everything is processed within the 
document. 

 Creating interactive PDFs is simple in so far as it 
does not require additional skills such as writing 
programme code for websites. (It requires, however, 
some training in using InDesign, ideally supported 
by good self-directed learning skills.)  

 You can turn your already existing PDFs into interac-
tive material. (The typical way to do this would be: 
adding interactive elements in Adobe Acrobat Pro-
fessional). 

 Teaching aids delivered as PDF look more profes-
sional than such provided in text processing formats 
(DOCX, ODT).  Your learners will be impressed by the 
range of capabilities included in a PDF. 

 PDFs are easy to distribute. 

 Interactive PDFs help your target group become 
more engaged. Learners are given the possibility to 
respond without even using a permanent internet 
connection. 

 Presentations are no more one-way. 

 Interactive PDFs can help you create content that 
leads to an action. They allow you better incorpo-
rate actions, such as submitting details, respond to 
mini quizzes or watching a video. This can make you 
more compelling and competitive among other ed-
ucators. 

Common Mistakes to Avoid

 It is quite common for educators to get excited with 
interactivity. However, too much of it can make the 
content tiring for the audience. 

 When you have a wide variety of options, it is dif-
ficult to keep consistency throughout the content.

 Monitor the size of the file that is created when add-
ing interactivity. Especially included videos can lead 
to undesired increase of file size. 

 Here is another drawback of the entire idea of inter-
active PDFs: The concept works well as long as your 
learners use something like a classical computer (PC, 
MAC). If they try to use your PDFs on their smart-
phones or other mobile devices, it may well happen 
that the PDFs lose their functionality just because 
the PDF reading software on these devices may not 
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be able to deal with it. Reading will work. Interactiv-
ity may be impeded. 

Online or Offline?

Interactive PDFs can be published both online and of-
fline. Readers use them offline.1 

1 With „Publish Online“, Adobe offers users of InDesign also a free hosting server for interactive PDFs. If you use this, your students 
work with your PDFs online.
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4.4.2 Creating accessible PDF

“Accessibility” of documents means: the document 
can be “accessed” (read, used) by all people, including 
those with some disabilities, especially with visual im-
pairment up to blindness, but also other problems e.g. 
of the musculoskeletal system. Depending on where 
you work, “accessibility” may be required by law or by 
company policies. Documents, especially those in ed-
ucation, are created to be readable and intelligible. So 
why not create them in a way everybody can use them, 
including people with special needs? 

In everyday practice this means that the document 
should be “readable” not only for the ordinary human 
eye. Rather, it should be possible that “assistive technol-
ogies” can process them. This includes screen magnifi-
ers, special colour settings, and most naturally screen 
readers (robotic voices reading a written document). 

To achieve accessibility in this sense, two things are to 
be done. 

To begin with, the document should be well-structured 
for the human eye. Rules to be followed coincide largely 
with what professional journalists and publishers have 
been doing for centuries. (For example: write an article 
always in a self-sufficient form. Don’t expect the reader 
to have read the headline first.) 

Second, the document should be well-structured for ro-
botic readers. The structure for robotic readers will usu-
ally be included in the page without being visible to the 
human eye. For example, if on a page there are several 
areas of text (columns, boxes, or what ever), the docu-
ment should include information (hidden to the eye, 
but readable for machines) about the order in which to 
read. That’s because a robotic reader cannot do what 
the human brain and eye can do: scan the entirety of 
a page and instantaneously decide along certain her-
meneutic criteria what to read next. The robotic read-
er needs information about the structure of a text that 
is interpretable for it. For example, it needs indicators 
what are the headlines, what is contiguous text, what 
are navigation elements, and what is just a letter head 
or logo that appears on each page but should not be 
read as it occurs each time. 

A document that is technically well-structured can be 
processed by software to assist people with disabilities. 
You may have learners with such special needs. 

In this chapter we will have a look how we can improve 
our PDF documents so that they fulfil accessibility cri-
teria. 

Adobe Acrobat Pro is the industry standard programme 
for editing and processing (rather than authoring) PDF 
documents. It provides various tools to check docu-
ments for accessibility, and to fix problems. We will use 
Adobe Acrobat Pro here, but of course, the same thing 
can be done with other PDF editing tools as well. 

Main PDF accessibility features that can be provided via 
Acrobat are features to make documents readable for 
screen readers (robotic readers) and screen magnifiers – 
programmes to selectively enlarge parts of a screen so 
that people with weak sight can read them. It includes 
also document colours to be swapped with high con-
trast colours. Individual steps are

For blind people (using screen readers) 

 set the language of a document so that a screen 
reader knows what to do

 set the reading order (“tagging”) for text elements 
on each page 

 set alternate texts for images so that the robotic 
reader would read aloud “Picture of a house in green 
meadows” when a picture of a house in green mead-
ows is on the screen; the robotic reader does not 
recognize the picture; it simply reads a line of text 
that the author of the text assigned to the picture 
for that purpose.

 re-open documents to the last viewed page. This 
helps blind people to get back to where they were 
with reading when they closed the document.

 adjust document zoom; generally a good setting 
is “fit page on screen”, that way screen readers and 
screen magnifiers can work optimally. 

For people who can read but need special visibility 

aids 

 highlighting form fields 

 disable text smoothing, which increases contrast

 display the document in other colours for better 
contrast  

There are various standards for accessibility of internet 
documents, for example the Web Content Accessibility 
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Guidelines (WCAG) and the PDF Universal Access (ISO 
14289). If you are generally interested in the topic, a 
source for quick oversight information is http://www.

section508.gov by the government of the United States. 
(There is no special prevalence here to standards set by 
that country; it just happens that they have a good web-
site on the topic in English.)  

What do I need?

 Computer or laptop 

 Adobe Acrobat Pro. – Note that this is not the Adobe 
Reader. Adobe Acrobat Pro is a full-sized PDF manip-
ulating tool, wide-spread in professional publishing, 
both print and screen. It is not cheap.  

 A word processor (such as Microsoft Word or Ope-
nOffice Writer) that allows you to output a docu-
ment as PDF. – If you have Adobe Acrobat Pro in-
stalled, the respective plug-ins should be available 
in your MS Office applications automatically.

How do I prepare?

Here are some rules for “accessible” PDFs. They are basic 
things that are good to know in advance before diving 
further into the topic. 

 The visible (and invisible) structure of your original 
document should be clear and easy to follow. Head-
ings, table of contents, links and bookmarks are 
elements to help structure a document. – That’s of 
course a thing everybody writing any documents 
should heed anyway. 

 Visual content (pictures) should have text alterna-
tives. That’s text to be displayed or to be read aloud 
instead of the picture. – We will show you how to 
create these. 

 PDFs must be properly tagged. Tags are (invisible) 
mark-ups in the document that provide structure, 
especially for robotic readers. – We will show you 
how to check for these tags and set or improve them.  

 The language of the texts should be specified explic-
itly so that robotic readers know what to do. – We 
will show you below how to do this.

 The security settings of the document should be 
operable also for users of assistive technologies. – 
Security settings include rules on what can be print-
ed, and whether a password is needed to read (or 
manipulate) the document. – If you have never used 
these settings in PDFs, don’t worry as you will most 
likely not be affected.

Fig. 4.36 – Two of the high-contrast 
colour settings available in Adobe 
Acrobat via Edit > Preferences > 
General > Accessibility. This can 
be helpful for people with certain 
forms of visual impairment. (If you 
are old enough, you may like the 
sight because it remembers you 
of your first steps with computers, 
in the 1980s and 1990s.)  
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Know how to make Acrobat read 

documents out loud to you 

One feature of Acrobat (Reader and Pro) not many peo-
ple know about is the ability to read out text aloud. You 
can test this very easily by switching the function on: 
View > Read Out Loud > Activate. In any open PDF docu-
ment click on something with your mouse pointer, and 
it should be read aloud (with some artificial voice and 
an ugly mechanic but intelligible pronunciation).  

Note: by default your computer system might provide 
only one single “voice” to use for reading, and that voice 
will most probably speak English only.  Although you in-
deed can make it read also your German, Spanish, Greek 
or Italian texts, and have fun with that for five minutes, 
that’s just a nonsensical game. So, if a “voice” for your 
language is not already available, you have to install ad-
ditional languages. That’s surprisingly simple. We show 
you how, below. 

View your documents in high 

contrast mode 

Also, you can make a quick experiment to get acquaint-
ed with “high contrast screen” views. You simply have to 
tell Acrobat to display documents that way. In Acrobat 
Pro or Reader: Edit > Preferences > General > Accessibil-
ity >  Document Colours Options. Try out the  various 
options. You may end up with screens like those below 
(Two of the high-contrast colour settings available in 
Adobe Acrobat. This can be helpful for people with cer-
tain forms of visual impairment): 

(See Fig. 4.36, previous page)

Letting a screen reader read your 

document aloud

There are various assistive tools available, e.g. high 
contrast screens as seen above. However, the most out-
standing tools are screen readers, that’s robotic voices 
reading aloud what your document says.  There are 
specialty software programmes to do that, both open 
source and commercial.1  Also, modern operating sys-
tems (Windows, Apple OS, Android) usually have some 
form of a screen reader built in. 

1 For more on that: https://en.wikipedia.org/wiki/Screen_reader. A list of currently available screen readers, with comparison of their 
features is at https://en.wikipedia.org/wiki/List_of_screen_readers.

2 All links mentioned here were tested in April 2019.

A basic screen reader is built in in Adobe Acrobat Pro 
and Adobe Acrobat Reader. Start it with View > Read Out 
Loud > Activate Read Out Loud.

You will probably find that this reads only English texts. 
Not good for you if you are living in some other coun-
try. The solution is: you have to install additional screen 
reading elements to your operating system. For Win-
dows the current solution (2019) can be found at http://

espeak.sourceforge.net/download.html. You have to follow the 
instructions given there. instructions by Microsoft on 
the same topic are available here: https://support.office.com/

en-us/article/download-voices-for-immersive-reader-read-mode-and-

read-aloud-4c83a8d8-7486-42f7-8e46-2b0fdf753130?ui=en-US&rs=en-

US&ad=US. 2

This let’s you add one or several of the most common 
languages in use . Once installed in your operating sys-
tem, you have to tell Adobe Acrobat (Pro or Reader) to 
use this in the screen reader. You do this via Edit > Prefer-
ence > Reading > Voice (dropdown field where the newly 
installed languages should be visible now.) This will look 
something like: 

When you listen to your document being read aloud, 
you may at the first moment be surprised as it is not a 
beautiful human voice presenting a text in good pro-
nunciation and prosody. What you will hear is most 
probably (and unless you use one of the more expen-
sive stand alone systems) a rather distorted voice like 
of a caricature robot. Screen readers are not made to 
provide you with the pleasure of a refined reading ex-
perience (a thing only a well-trained voice actor can 
do). They are software tools to help especially those 
who cannot use their eyes for reading; aesthetics is not 
considered.
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Where to look for help?

The Adobe Help Centre (in the internet) has useful tips 
on how to get started. There are tutorials and step-by-
step instructions. You can also join the community fo-
rum to ask for specific issues. 

https://helpx.adobe.com/gr_en/support.html 

Especially for accessibility: 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibili-

ty.html

If you are interested in the topic of “accessibility” of doc-
uments more generally: the US government has a web-
site on the topic that is very good. It also offers check-
lists for accessibility of various document formats.

 http://www.section508.gov

A basic video tutorial for using Adobe Acrobat for creat-
ing interactive PDFs can be found here:

https://www.youtube.com/watch?v=kWCciN7y64M

What do I do?

1) Checking the accessibility of an 

existing PDF

For checking accessibility of PDFs, Adobe Acrobat 
has an automated way, called Full Check. This feature 
checks a PDF for many of the characteristics that acces-
sible PDFs should have. 

 Choose Tools > Accessibility. Then the respective 
toolset will be displayed in the toolbar.1

1 If your Acrobat has a different screen language, you might need to look out for something fitting the idea. In German the tool 
is called Ein-/Ausgabehilfe.   If a tool like that is not visible at all, use View > Tools to select the tool you need. It will henceforth 
be visible in the Tools column right hand side of your Acrobat window.

 Click on the Full Check button. You get displayed a 
large dialogue with plenty of settings.

 In the Report Options area, choose options for how 
the results shall be displayed. Basically you can 
choose between a report to be saved somewhere 
on your computer, and “Create comments in docu-
ment”. 

 In case you want to check only specific pages in the 
document, select a page range.

 Choose one or more of the Checking Options. You can 
also select from various standards to be used in the 
Checking Options - Name dropdown field. There you 
find e.g. the “Section 508” standard used by US au-
thorities to ensure accessibility of their documents; 
but also other standards. If you choose “Adobe PDF” 
as the standard to check against, the check will use 
the following criteria: 

 Click Start Checking.

 The results will be displayed in the Accessibility Checker 
column on the left of your screen. (What you see 
there is actually the report that has also been saved 
to some place on your computer.)

(See Fig. 4.39 on next page)

If you selected Create comments in document your 
document will show highlighting like this:

Fig. 4.38 – The “Adobe PDF” criteria set for checking 
for accessibility issues. This is a relatively concise set 
of criteria. Some of the other standards available have 
considerably more detailed lists of criteria. 
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Fig. 4.39 – Window of Adobe Acrobat Pro (here version X) with a document opened in the middle, the tools column to the right, and the 
report in the column to the left. 

Fig 4.40 – Reading order view  of a page. On this document 
the Add Tags to Document command was used. The tags 
are more or less okay, but could be improved by assigning 
individuals tags to the headlines (as they are currently 
included in tags 3, 5, and 7 together with text. 

Fig. 4.41 – Left column of your Acrobat window. The Order pane 
is open. We right-clicked on one of the elements on Page 1 and 
got a dialogue displayed to adjust the properties of the element. 
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Fig. 4.42 – Document with highlighted sections where 
problems were identified. 

 According to what the report says, and of course 
according to what accessibility features your docu-
ment is set to have, you can now start fixing the is-
sues. Here are some typical issues, and quick advice 
how to solve them: 

 Language not defined: This means that 
screen readers will not be able to read your 
document correctly. It might happen that 
your French text will be read by a voice try-
ing to read it as if it was English (if you want 
to have fun, try). – For correctly setting the 
language use File > Properties > Advanced > 
Language

 Image does not have alternate text: Select, 
in the left column, the Order pane. Pictures 
that do not have alternate texts should be 
marked like so: 

 You can now right-click on the black note and 
select Edit Alternate Text. 

 Document not tagged. This means that the 
various elements on the pages (headers, text 
blocks, pictures, etc.) are not marked explicit-
ly as such. You can use the Add Tags to Docu-
ment command (in the tools column, section 
Accessibility) which will do the tagging au-
tomatically, as good as possible. This works 
usually well in documents that are not too 
complex. If you are not happy with the result, 
you can fix everything manually by using the 
Touch up Reading Order tool (same place). Or 

1 May be called completely differently in your localized Acrobat version. In German this is called „Barrierefreie PDF-Dokumente 
erstellen“.

you can use the Touch up Reading Order tool 
right away without a detour through the Add 
Tags tool.

 To check your document structure visually: open the 
Order pane (left column, where the bookmarks are) 
by clicking this icon:

 You now will get your pages displayed in “reading 
order view” like this:

(Fig. 4.40 on previous page)

You can now use the Touch up Reading Order tool. 
Basically you mark with the mouse a rectangle 
around any element on the page, then press one of 
the buttons available to identify the marked section 
as headline, text, picture, table, or whatever it is. 

Alternatively, you can access all individual elements 
in the left column, Order pane (right-click on the 
items listed there), and assign new values. 

(See Fig. 4.41 on previous page)

2) Use the Make Accessible action 

As an alternative way to do it, Acrobat Pro has the Make 
Accessible action that provides you with step-by-step 
guidance on how to make a PDF accessible. 1

“Actions” in Acrobat are tiny programmes to carry out 
a series of tasks that otherwise would need to be done 
manually one by one. The Make Accessible action leads 
you through a number of checks and shows you what 
needs to be fixed. 

 First, open the PDF that you want to check and im-
prove.

 Choose Tools > Action Wizard. Then, the Action Wiz-
ard toolset is displayed in the toolbar. 

(See Fig. 4.45)

 From the Action list, choose Make Accessible (in Acro-
bat Version X it is Create Accessible PDFs)

 The panel appearing displays each task that needs 
to be done in order to make the document accessi-
ble, as well as instructions of how to execute.

(See Fig. 4.46)
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In the process you will repeatedly get advice on 
what to do, for example:

 Follow the advice given. For example when it says 
“Add alternate text to images ad needed”, do so. – 
From notes such as this it becomes clear that Adobe 
expects you to know how to do this. (That’s why we 
showed you the manual way first. Old Chinese prov-
erb: There is no knowledge without knowing.)

Teaching Benefits

You will use accessibility features for your PDF docu-
ments especially when you have learners with special 
needs. Whilst in general adult education it will not hap-
pen so often, it might. Often blind and visually impaired 
people will already be equipped with assistive technol-
ogies (special screen readers etc.), and in this case by 
preparing your documents accordingly you are really 
assisting them and making their life easier. 

Admittedly, doing this for only one learner, with docu-
ments that are one-off for a one-semester course, is per-
haps a bit unrealistic with regard to the work required. 
However, if you have documents that are expected to 
be used over years and are directed to a wider public, 
checking them for accessibility features is definitely a 
good idea.   

Common Mistakes to Avoid

 Be careful with colours. Good contrast for reading is 
important not only to visually impaired, but actually 
for everybody.

Advice given during the “action”. Obviously it is 
expected that you know how e.g. to add alternate texts 
to images. 

Fig. 4.45 – Adobe Acrobat Action 
Wizard (here from Acrobat X, 
other versions may appear 
slightly different.) 

Fig. 4.46 – The “action” starts with showing you the steps you 
will be going through. 
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 Do not use images just to decorate your content. All 
material included in your document should convey 
useful information.

 Pay attention that repeating headers and footers 
should be exempt from the reading order for screen 
readers. 

  It is better not to try make your interactive PDFs (see 
previous chapter) “accessible”. Making PDFs accessi-
ble may remove crucial elements of their interactive-
ness such as links or included files. 

Online or Offline?

For making your PDF “accessible”, use the Adobe Acro-
bat Pro, which is by its nature an offline application. The 
resulting PDF file can of course be published both of-
fline and online. 
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4.5  Games

Games and gamification are becoming a very impor-
tant tool in the blended educators’ skillset. Games allow 

learners to enjoy their learning, and look at topics from 
a new direction. 

4.5.1  Creating and Using Interactive Games

The internet allows you to both play and create a wide 
range of games that can be very helpful for learners. 
This activity is focussed on the creation of quizzes and 
word games. We introduce you to two of them in detail. 
For more examples, see Chapter 7 where more tools are 
presented briefly.

 What do you need?

 A mobile phone, desktop, laptop or tablet

 Internet access

 Game generator tools – We will introduce you to 
three of them. The idea is simply to give you some 
idea what is available. You can take this as a point 
to start to search for others. New gaming opportuni-
ties in the internet with an educative agenda appear 
constantly.

Where to look for help?

Generally on the topic of games in education:

 A good collection of short, introductory articles and 
resources on the topic of game-based learning is 
provided by www.edutopia.org (run by George Lu-
cas Educational Foundation). This is predominantly 
school-oriented, but it is not bad for a first glance. 

https://www.edutopia.org/game-based-learning-resources

More tools:

 On word-grabber.com you can find various word 
generator tools to make words from letters for dif-
ferent word games like Scrabble Word Finder, the 
Words with Friends Cheat and Anagram Solver. The 
site is one of several run by a small company based 
in Bavaria, Germany, that specialises in crowd- based 
information portals. 

 Free crossword generators, for example:

https://crosswordhobbyist.com (we present this below)

http://www.crauswords.com

http://www.eclipsecrossword.comHow do I prepare?

Reading this book will be helpful but the most useful 
thing for you to do is to actually go and try play the var-
ious games. 

In this chapter we will introduce you to two tools: Ka-
hoot, a platform to create and play quizzes and surveys, 
and Crosswordhobbyist, a tool to create crosswords. 

 For the Kahoot quiz,  go to https://kahoot.com  and regis-
ter an account filling in your role (educator). You will 
create your username and a password. 

 For Crosswords, except from registering an account 
at https://crosswordhobbyist.com, you may, in preparation, 
think about a list of words relevant to the topic of 
your classes, plus “clue” for each of them. The clues 
can be used in the crossword, as well as for hints in 
Hangman, and as questions in the quiz activity.

What do I  do?

1) Create Quizzes and Surveys with  

Kahoot 

Kahoot is an internet platform offering user-created 
quizzes and surveys that can be used for spicing up 
events starting from normal classrooms up to very large 
auditoriums. Kahoot quizzes and other online tools are 
used by schools, universities, and in other educational 
environments. 

The platform is run by a company in Oslo, Norway. It 
was started in 2013 by a number of students and aca-
demics of the Norwegian University of Technology of 
Science. In 2019 it announced that it had registered 2 
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billion players with 60 million games created by users.1 
The company name uses an English expression “cahoot” 
meaning to be in company or partnership. 

The main product are user-generated multiple-choice 
quizzes that can be accessed via a web browser, smart-
phone apps, etc. 

The most typical way to use Kahoot-quizzes is, first, 
to create a quiz for a certain lecture you are giving. In 
the classroom you then can display the quiz on your 
whiteboard. Questions will be displayed on that screen. 
Students use the Kahoot! app on their smartphone: af-
ter entering the code number of the current quiz, they 
can use their smartphones as voting devices to answer 
the multiple choice questions displayed on the white 
board. A typical quiz could for example have 10 ques-
tions. Participants get scores for correct answers, with 
the speed of answering also factored in. Between the 
individual questions, the current scores of the partici-
pants are displayed on the white board, which adds a 
spirit of competitiveness. 

This can be fun for students while offering an enter-
taining way of repeating the core things learned in that 
lesson. Obviously this approach will work best with 
learners who are what today is called “digital natives”, i.e. 

1 Data from their website: https://kahoot.com/company, accessed April 2019. Note: „2 billion players“ is not to be misunderstood 
as „2 billion registered users“. It means  2 billion counts of somebody participating in a quiz etc.

people who operate their mobile phones all day long 
and are familiar with using all sorts of apps. It will not 
work so well with learners who are not familiar with us-
ing smart phones that way. 

No user account is needed for simple participating in 
quizzes. For creating quizzes, however a user account is 
needed. Basic user accounts are free. More advanced ac-
counts are available for 12 and 36 Euros annually (prices 
as in April 2019).

Test our sample quizzes

Enough theory. Just try it! We created a mini quiz about 
the fascinating topic of Blended Learning for you:

https://create.kahoot.it/share/blended-learning/0093de63-d390-

4d88-bd1b-0a992fd2087d

This one is quite similar, created by somebody else: 

https://create.kahoot.it/share/blended-learning/189beb65-d0c2-

40bb-a40d-0ba83a84caa4

This one is about current issues of sustainability on 
planet earth. It was one of the most-used quizzes in 
April 2019: 

Fig. 4.50 – A typical screen of 
a simple quiz. The question 
is displayed on top. The four 
answers have buttons with 
different symbols and colours. 
These buttons are displayed 
also in the smartphone app 
(right). 

Blend-it-well Handbook 
4.5.1  Creating and Using Interactive Games

4



115

https://create.kahoot.it/details/1ec244d9-87fa-45fa-81b6-c3fe63e-

fafd0

These are quizzes with multiple-choice questions with 
2-4 answers. 

Currently Kahoot allows users to create three types of 
online games:

  Quizzes with multiple-choice questions

  Quizzes where four answers have to be put in cor-
rect order

  Surveys, a classical voting tool: participants can vote 
on up to four options (without there being wrong 
and correct answers). 

Kahoot can be used to review students’ knowledge, for 
formative assessment,  or as a break from traditional 
classroom activities. 

Create a quiz yourself

For creating your own quiz in Kahoot, log in to the plat-
form and choose an activity you want to create: a quiz, 
a jumble, or survey. 

The website will lead you through the process of creat-
ing your quiz. Here are some tips to keep in mind: 

 Questions have a 95 characters limit. 

 There can be 2-4 answers, each with a 60 characters 
limit. At least one of them must be marked as “cor-
rect”

 You can set a time limit to answer the question. The 
default is 20 seconds, but you can set it between 5 
and 120, depending, chiefly, on how thoroughly the 
question and the answers need to be read.  

 You can embed an image or a YouTube video into 
the question. Thus, for example, you can show some 
object and ask something about it.  

 Select whether you want to make your game public 
or private. Public games can be used by everybody, 
private ones only by people who know the link. 

Play the game – or let your students 

play

 When you want to launch a game, select it from 
“MyKahoots”, or via the link identifier, and press the 
Play button. You will get a game PIN (a number con-
sisting of 6 figures). 

 To participate, learners start the Kahoot app on their 
smart phones or computers, enter the game PIN, 

Fig. 4.51 – Two types of 
crosswords available on 
the Crosswordhobbyist 
website: “Standard” 
and “Newspaper Style”.  
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and also some make-shift username (pseudonym) 
that will be displayed on the central screen. 

(See Fig. 4.50)

2) Create Crosswords with 

Crosswordhobbyist

The Crosswordhobbyist offers assistance for quickly cre-
ating crosswords. 

https://crosswordhobbyist.com

Here you can create two types of crosswords, “Standard” 
and “Newspaper”: 

(See Fig. 4.51)

The “Newspaper” type is extremely complex to create. 
Even experienced crossword creators need 3-4 hours to 
create one such (with 15 x 15 squares), and beginners 
may need 6-8. All the placement of words must be done 
manually, or better: by the human brain. Clearly not an 
option for the average adult educator. Not due to lack of 
brain, of course, but due to lack of time.

Much easier is the “Standard” type. Here, the task is sim-
ply: collect a number of words (ten perhaps) that be-
long to your teaching topic. On pressing a button, the 
software behind the website will arrange them in the 
best way possible, i.e. with as many cross sections as 
possible. 

For each word you also enter a “clue”, that’s the descrip-
tion of the word to find, for example, the famous “male 

sheep” when “mutton” is the solution. Or, of course, 
something more in the form of a riddle: “What we do 
when we are not passive”, as a clue for “activity”. 

Here are some tips for using the Standard crosswords 
mechanism of the Crosswordhobbyist website: 

 Enter all your words in the ‘Auto-Arrange’ section at 
left.

 You can arrange your words manually, automatical-
ly, or any combination of the two.

 You can add all your words at once or a few at a time, 
as you think of them. If you are adding words a few 
at a time, try to start with at least 6 words to increase 
the likelihood that they all intersect.

 You can also add words directly to the grid, if that’s 
your style. Type across or down, and use the space-
bar to switch directions.

 When you are ready, click the Make Printable button 
to save your puzzle. That’s the moment when you 
need to pay. Subscription plans cost 4,25 - 6,80 USD 
per month, payable via credit card (Paypal was not 
accepted when we tested in April 2019). Conven-
iently you can also pay for individual puzzles (6 dol-
lars).

 Your puzzles are saved to your account. They are 
accessible from any computer with connection to 
the internet. They can be solved online, or you can 
download them as PDF. 

(See Fig. 4.57)

Fig. 4.57 – For testing the tool we quickly created a „Blended Learning“ crosswords. That’s how it 
looks on the computer screen at the time of creating. 
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Teaching Benefits

 Using games, an educator can organise teamwork 
and competition which is motivating for some types 
of learners.

 Games bring interaction to the classroom. Some 
types of learners enjoy the competitive nature of 
the game and comment that it helps them retain 
concepts.

 Some games are good for making people cooperate 
in groups.

 Word games can be used to introduce key words/
terms of a topic; quizzes help to check learners’ per-
formance, and to consolidate the understanding of 
key concepts. 

 Some games can be used in the online part of a 
Blended Learning environment.

Common Mistakes to Avoid

In Kahoot:

 Remember that there is a character limit of 95 for 
questions and 60 for answers.

 Be sure to extend question time limit in a proper way 
as images don’t show before answer options do. 

 There is no limit for the number of questions in 
quizzes and surveys, but it is recommended to keep 
them between 10-20 questions.

 If you’re a Kahoot admin or educator of a team, you 
can edit and host other educators’ quizzes or sur-
veys, but at a time only one person can edit a Ka-
hoot.

 Be sure your audience (your students) are familiar 
with using smartphones and apps. If there are peo-
ple without smartphones in your audience, they 
cannot participate and might feel excluded.

In Crosswords:

 Sometimes it’s not possible to connect all the words 
from your list into an intersecting group because the 
combination of letters doesn’t line up. To solve this 
you can try adding word, or you can set the number 

of groups you are willing to accept at more than 1. 
Bigger numbers make larger puzzles.

 In Newspaper style crosswords (which however are 
time-consuming to build), if you use grey (instead of 
black) squares to fill the gaps, you will need less ink 
for printing

Online or Offline?

Online games are, obviously, played online. 

 Kahoot can be played online (with users sitting at 
their devices at home or elsewhere), but this still 
requires a synchronicity (everybody participating at 
the same time). Unless a person fills in a quiz just for 
herself, without competing others. The more typical 
case is however to use Kahoot quizzes and surveys 
in a classroom or an even larger auditorium.

 Crosswords can be played online one by one. Or 
they can be used in classroom setups, for example 
to be solved in groups. In this case you will have to 
print your crosswords out.  
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Fig. 5.58 – This is how it looks when output to PDF, ready for use.

Fig. 5.58 – The crosswords created on previous pages how it looks when output to PDF, ready for use. 
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Fig. 5.58 – This is how it looks when output to PDF, ready for use.
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4.5.2  Using Digital Badges

Digital badges are a form of recognition of educational 
achievements. They are a bit like the textile badges that 
for example youth scouts organisations hand out to 
girls and boys when they have proven to be able to do 
certain things: light a fire, erect a tent, and so on. Digital 
badges are similar, just in the internet. In this section, 
we present the topic in more detail. There will also be 
two or three practical things for you to do in order to 
get a feeling for what digital badges are. Don’t, howev-
er, expect a full introduction into issuing digital badges 
to your learners. This would require an entire book. 

What do I need?

 Internet access

 Typically (but not necessarily) an LMS (Learning 
Management System) for e-learning.

 Learners who are susceptible to symbolic recogni-
tion of achievements. Typically younger learners are 
more interested than older ones. But adults who love 
collecting will enjoy the digital badges experience.

 If you take it very seriously, you have to make sure 
that the badges you issue are aligned with the ed-
ucational standards of your country. (See below the 
example how Technical University Dublin uses digi-
tal badges.)

Where to look for help?

 A good, comprehensive introduction into digital 
badges is on the OpenBadges website.

https://openbadges.org

 History and background are explained, along with 
technical details, on the elearningindustry.com 
website in form of a 15 pages e-book (for free, but 
you have to leave them your e-mail address). De-
spite its brevity, it is of high quality as it manages to 
see things from a certain distance not usual for this 
industry: 

https://elearningindustry.com/guide-to-digital-badges-how-used

 Also have a look at the Wikipedia pages for “Digital 
Badges” and “Open Badges”

How do I prepare?

Read this section of the book

What do I do?

One topic you will come across at some point as a teach-
er or educator facilitating Blended Learning is digital 
badges. 

Digital badges are a form of recognizing a learner’s ef-
forts and achievements. To understand the concept, 
think about the badges – physical signs of metal and 
textile – stuck to the breast of high ranking or well-per-
forming military persons, most prominently in the So-
viet Union. Or if you are familiar with the traditions of 
some youth scouts organisations: some of them hand 
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out textile badges that boys and girls can sew onto their 
shirts for achievements like lighting a fire or erecting a 
tent. 

This concept has, beginning with about 2010, been 
introduced into online learning. It started from online 
games, where a user – identified through his or her user 
account – got awarded certain “badges” usually in form 
of images shaped like medals. 

From there, the concept was transferred into online 
learning environments. Various systems were devel-
oped, both commercial and free, that should allow as-
signing “badges” for achievements to individuals across 
platforms. This means that these badges are not fixed to 
a certain environment, for example the Learning Man-
agement System (LMS - think of Moodle, Canvas, etc.) of 
a certain adult education organisation. Rather they are 
fixed to the individual user (i.e. his/her e-mail account), 
and different online learning environments (or educa-
tion providers) are able to process these badges: they 
can create such badges fitting their courses, and assign 
them to their learners. 

1  Badgr is an open source project started in 2014 to serve as a reference implementation for Open Badges.

If you are working in an adult education organisation 
that provides online teaching (or Blended Learning) it 
is possible – but not obligatory – that your organisation 
uses such badges already. For example, Moodle has 
badges built in since 2012. Other such platforms such as 
Canvas also have them. It is, however, well possible that 
your organisation simply does not use them although it 
uses an LMS. (See below the section about problematic 
aspects of digital badges.)

(See Fig. 4.61)

You can also use the services of a number of companies 
and organisations who provide badges implementation 
either for free (in smaller quantities) or for paid subscrip-
tion. Such organisations include Badgr (www.badgr.com)1, 
Accredible (www.accredible.com) and RedCritter (www.
redcritter.com). These offer various services sometimes 
including an online application that helps do create 
nice looking images for the badges. 

(See Fig. 4.62)

“Open Badges” is the name of a group of specifications 
and open technical standards originally developed by 
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Fig. 4.62 – If you find one of these logos on a 
website of an educational organisation, you 
know that they issue digital badges based on 
the Open Badges standards.

Fig. 4.61 – Using the services of the Accredible company 
(www.accredible.com) we quickly created this badge for 
potential use by the Blended Learning project. The idea 
is to assign it to people who in some way prove that they 
have read the book. But so far we only created the visual 
badge; we have not yet done all the other steps necessary. 
There is also a special technology (called “baking”) to 
include certain invisible data into the image.   
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the Mozilla Foundation1 since 2011.2 The Open Badges 
standard describes a method for packaging information 
about accomplishments, embedding it into image files 
as a digital badge, and establishing an infrastructure for 
badge validation.

As you see from the above paragraph, we are here al-
ready deeply into technology relevant predominantly 
for IT personnel who has the task to integrate a badge 
system into some organisation’s online learning envi-
ronment. Most probably your are not such a person, 
and we will not dive deeper into these technologi-
cal aspects. However, it is good to have an idea of the 
“ecosystem” (the network of stakeholders) that makes 
a badge system work. There are “issuers” (schools, adult 
education organisations, etc.) “recipients” (the learner), 
“displayers” (various websites and online environments 
where the badge can be shown, and “consumers”, that’s 
in this case people to whom the recipient (learner) will 
eventually show the badge to prove how skilled she is. 
This could for example be an employer.

1 Mozilla Foundation is a foundation in the USA. It was created to support free software products such as the Firefox Browser 
and the Thunderbird e-mail application. Income is generated chiefly through contracts with Google (and other search engine 
providers) who pay for their search engines being set as default search engine in the Firefox browser. For these contracts, 
Mozilla Foundation runs a 100 per cent subsidiary commercial company, Mozilla Corporation, with revenues of about 60 
million dollars per year (data as of April 2019).

2 A paper titled An Open Badge System Framework published in 2011 by Peer2Peer University and Mozilla Foundation is 
commonly seen as a cornerstone oft he development. See this article under http://bit.ly/badgepaper4.

(See Fig. 4.63

Back to practice: 

Below you see a badge one of the authors of this book 
received will writing this book and testing various 
things: 

Fig. 4.63 – The Open Badges Ecosystem with the various types of stakeholders involved. (Diagram by Erik Knutson, Concentric Sky, 
licensed CC-BY) 
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This is a badge by the name of “Navigator”. The author 
of this article got it awarded after he fulfilled a number 
of tasks related to using an internet browser: tasks like 
typing an URL into the address field, re-sizing a resizable 
form field, and so on.

You can try this yourself. It will cost you 5-10 minutes:  

 Go to

 https://backpack.openbadges.org 

 and create yourself an account. This “Backpack” is 
used to store your badges. You identify yourself via 
your e-mail account.1 

 Go to 

http://toolness.github.io/hackasaurus-parable/navigator-badge/#  

 This is a website giving you a quick task to fulfil, on 
completion of which you will get awarded with the 
“Navigator” badge proving that you have demon-
strated to be able to use an internet browser skilful-
ly. – This badge was created to give a simple exam-
ple how such badges work. The badge you get will 
be sent to the “Backpack” mentioned above. 

One important feature of digital badges is that their 
various claims must be verifiable. Therefore, each badge 
has a set of information fixed to it. For the “Navigator” 
badge this looks as follow: 

(See Fig. 4.64)

1 Note however that this service is planned to be retired, and all accounts are going to be moved to the “partner” project Badgr 
(www.badgr.com). When we checked in Mai 2019, Backpacker worked still fine.

This includes information about the issuer (who award-
ed the badge), the awardee (who received the badge; 
here blurred out by the book editors for privacy), and 
what are the criteria for awarding the badge. To see 
these details, one can follow the links. (In this case, the 
“criteria” are simply the website where one can fulfil the 
tasks.) 

Some or all of this information will be shown wherever 
the badge is displayed, but it is also stored within the 
digital badge’s meta-data (i.e. information hidden in the 
image) so it can be verified any time – even if you only 
have the image.

Problems

A dose of scepticism 

Back to the general context. When you read information 
on digital badges published by organisations (compa-
nies included) who provide them, you will usually find 
an enthusiastic sermon on how useful badges are, espe-
cially how motivating they are for learners. 

But it is important to look also at the other side. First, 
although there are many education providers who use 
digital badges, there are also many who don’t. Some out 
of inertia, some for good reasons. 

Fig. 4.64 – Information given on the issuer of a badge, and other details. These data are stored in the badge 
itself and can be read at any time.
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Criticism of digital badges points out that digital badg-
es come with significant problems or question marks. 

 Given the long history of physical badges in military 
context, some critics say that the proximity to mili-
tary culture is unbecoming for the humanistic idea 
of education. Education should be a means of au-
tonomy and emancipation of the human being, not 
of discipline and subordination. 

  Badges have been criticized for rewarding tasks that 
are not inherently interesting to badge recipients. 
The argument is that badges are created to promote 
behaviour that aligns with the goals of the badge is-
suer, and not necessarily the badge recipient.

  Some critics have observed that badges are a type of 
extrinsic motivator that could compete with an indi-
vidual’s intrinsic motivation for accomplishment and 
mastery. 

  A permanent problem of badges is their validity: can 
they be viewed as “trusted credentials”? For exam-
ple, in fact the badge earner’s performance is often 
not directly observed, so there could be some diffi-
culty in making sure that the badge is awarded to 
the person who completed the assignment or met 
the specific criteria. Is an e-mail address sufficient to 
prove the identity of a badge earner? 

  Some sceptics see the “gamification” of education 
critically. They feel that students would be driven to 
be concerned with earning the most badges rather 
than focusing on the material presented. 

  There is also the danger of a slew of badges that do 
not mean anything at all, like earning a badge be-
cause your name starts with the letter A. Issuers may 
feel compelled to issue such badges just in order 
to keep learners (who might be paying customers) 
in good mood. The creation of these meaningless 
badges reinforces the issue of validity because now 
the badge earner needs to decipher which badges 
are valuable, and various institutions need to do the 
same.

Benefits

A positive perspective

After so much criticism, should we at all consider the 
use of digital badges in (non-military) adult education? 
There is at least one aspect that can be used for a strong 
argument in favour of digital badges in adult education: 

For many years now the countries in the European Un-
ion have been trying to develop their education systems 
further in order to get away from acknowledgement of 
time spent in the education system (“she has passed 
a 5 years higher education course in xyz”) to acknowl-
edgement of concrete skills and competencies (“she has 
proven to be able to write a book that complies with sci-
entific standards”), ideally independent of time spent in 
the system. This long-term goal, labelled “competence 
orientation”, has proven to be difficult to achieve, espe-
cially as the idea is to create a uniform system of rec-
ognition of skills and competencies across all sectors of 
education (school, vocational, higher, non-formal, etc.) 
and to include also skills and competencies that have 
been achieved by the individual completely on herself, 
without the involvement of an educational institution. 
This overarching (dreamed of ) system is called the Euro-
pean Qualification Framework (EQF), which breaks down 
into country sub-systems called National Qualification 
Frameworks (NQF). 

One attempt to realize such a method of recognition of 
skills and competencies of the individual is the so-called 
Europass initiative to provider individuals with stand-
ardized documentation of their skills and competencies 
including CV, documentation of experience abroad, and 
various credentials about educational achievements 
and competencies, made comparable between coun-
tries.  However, getting this system broadly accepted 
seems to be a very long process. 

All the more it strikes the eye that digital badges actu-
ally deliver many of the things the EU countries try to 
achieve with these policies: they provide recognition of 
skills and competencies on the individual level; they are 
international; and they are independent of sectors of 
the education system.

Therefore, perhaps can digital badges become a step 
towards a common competence-oriented education 
system in European countries? 
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And in Reality? 

What are we really doing?

So far for theory. Looking at practice can bring further 
insights. While writing this book, we quickly asked 
around at organisations involved in the project (and 
also one external) to see what role digital badges actu-
ally are playing in their everyday educational work. Here 
is what we found:  

TU Dublin is clearly a champion in using digital badges: 
they use digital badges in a number of educational pro-
grammes implemented through both the Moodle and 
Blackboard systems. The programmes range from IT 
to Education/Pedagogy; and to more learner-focussed 
content such as Induction and Volunteerism. Badges 
are both pre-existing badges, and badges created for 
specific modules. Some badges have accreditation (or 
recognition) from discipline-specific professional bod-
ies. Often the learners are awarded a number of badges 
per module, so for example if a learner has to do one 
activity (or milestone) for each week in a module, the 
learner may be awarded a badge per completed task. 
Students extol the virtues of digital badges, specifically 
mentioning that they aid in the pacing of a module, as 
well as giving a clear roadmap to the content associat-
ed.”

VHS Hannover has a proprietary Moodle platform 
used  basically for computer courses (computer liter-
acy, IT) and as an add-on for some language courses. 
As digital badges are a built-in feature of Moodle, they 

are available, however, they are not used systematically 
but perhaps by individual teachers who on a course-
by-course basis decide to use them. Overall, the use of 
badges is currently a marginal thing at VHS Hannover. 
This has clearly also to do with the type of learners VHS 
Hannover has: they are interested in the actual topic 
they learn, and in the social experience with co-learners. 
Most of them would see digital badges as something 
from primary school where teachers gratified them with 
stars written into their notebooks for well-done home-
work. 

Ljudska universa Žalec does not use badges so far. 

Västerås folkhögskola is a Swedish adult education or-
ganisation providing many online and distance courses 
in a professional way, partly to enable people living in 
remote places to partake in their courses. Asked if they 
used digital badges, they answered us, displaying their 
typical humanistic Scandinavian understanding of edu-
cation: “Sorry, we do not make use of badges or other out-
side rewards, just the participants’ inner pride and deep 
personal satisfaction.”

Online or Offline?

 Using digital badges somehow seems to be requir-
ing an internet connection. Badges themselves (the 
images including the data hidden in them) can be 
stored on non-connected computers. 

 Sewing textile badges for your classes can be a fun 
project, too.  
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4.6  Searching 

Searching in the internet is sometimes an under-esti-
mated activity. Many of us are so used to it in everyday 
life that we take it for granted and do not think about it 
very much. However, there are things to consider when 
internet search is used in a context of education and 
learning. 

In this chapter we will focus on two different topics re-
garding internet search:

One is related to you as a teacher who wants to prepare 
e-learning materials for Blended Learning contexts. We 
introduce you to techniques of searching especially for 
multimedia content that you may not be fully aware of 
even if Google is your daily companion for quickly look-
ing up something. Of course there would be much more 
to say. Take the section on multimedia search simply as 
an appetizer.  

The second part of this chapter focusses on using the in-
ternet as a source of information for students, and thus 
as a method of learning through self-directed work. 
This is largely based on constructivist and connectiv-
ist  concepts of learning: the claim that learning works 
best when a topic is not presented to students as a 
ready-made unit; rather students should explore things 
themselves step by step, in their own way and pace, and 
thus construct their own understanding related to ex-
perience they already have as the individuals they are; 
and that learning should make use of networks where 
people mutually recognize and apply their different 
pre-existing knowledge and competences. One form of 
leading students into such self-directed learning activ-
ities are Web Quests. You will learn about them in the 
second part of this chapter.

4.6.1  Searching for Multimedia Content

Multimedia is a frequently used word today. But what 
does it actually mean? Here is a short definition: “Mul-
timedia is content that combines different forms such 
as text, audio, images, animations, video, and interactiv-
ity.” In contrast, traditional media concentrates on one 
form of content delivery. (Hence one could call them 
“monomedia”). For example, newspaper publishers 
once concentrated on information printed with ink on 
paper. Music cassette producers sold magnetized plas-
tic ribbons that could be used to reproduce sound. With 
the advent of computers in everyday life, the separate 
media started to merge, giving raise to “multimedia”: a 
form of delivery that uses virtually all possible channels 
simultaneously. One day, sensory and olfactory chan-
nels will be used, too.  

So, in a strict sense, multimedia is a word for media that 
use multiple channels (or “modes”, as communication 
and education academics call it) to address multiple hu-
man senses: show a text, include a movie, let the user do 
something (interactivity), and so on. That’s the narrower 
meaning of the word. In a broader sense, the term “mul-
timedia” is also used as a short word for “pictures, vid-
eos, audio etc.” without these modes being necessarily 
combined. “I use multimedia in my lessons” often means 
simply “I hand out written material, I draw pictures, and 
I show movies.” 

In this section we will look at two different approaches 
to retrieving specific multimedia content from the inter-
net. First we will look at searching for images using the 
TinEye Multicolr (https://labs.tineye.com/multicolr/) search tool. 
Second we will look at a search tool for multimedia con-
tent (https://search.creativecommons.org/) licended for free use.

What do I need?

 A computer

 Internet access

 The TinEye Multicolr site:

 https://labs.tineye.com/multicolr

 Creative Commons search: 

https://search.creativecommons.org

Where to look for help?

Helpful websites

 The TinEye help page:
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 https://tineye.com/how

 The TinEye API: 

https://services.tineye.com/TinEyeAPI

Useful books

 Simone Aliprandi (2011): Creative Commons: A User 
Guide. Ledizioni Publishers.

 Sarah Pearson, Paul Stacey, and Sarah Hinchliff 
(2017): Made With Creative Commons. Ctrl-Alt-Delete 
Books.

How do I prepare?

 The first thing to do is decide what type of content 
you are looking for. Be as specific as possible. If you 
are looking for an image, sketch on paper what you 
would like to find; if audio or a movie, note down a 
sentence or two about what you want it to contain. 
(These are simple techniques to become aware of 
your ideas and intentions. Some people do not need 
this, for others it is helpful.) 

 Next decide what impact you want the multimedia 
to have on your learners, and well as what mood you 
wish to set by using it.

 Determine how much storage space you have avail-
able to store this content.

1 In June 2019 it was not possible to find this service via the www.tineye.com start page, but the direct link as stated above was 
working.

What do I do?

1) Image Search by Colour 

 Go to the TinEye Multicolr page. 

https://labs.tineye.com/multicolr

This site allows you to search images by colour. The 
site uses the picture database of Flickr (a large pic-
tures and videos sharing website).1

 Click on one colour on the colour palette:

Each colour you add will appear in the “Slide Divid-
ers” beneath the colour palette:

 Also images of that colour will appear in the main 
window

 Click on another colour on the palette and it will ap-
pear in the “Slide Dividers”

 

 The main window will have images with 50 % green 
and 50 % red content

 If you wish more green than red, slide the bar in be-
tween the two colours to the right:
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 The main window will now have images with 70 % 
green and 30 % red content

 If you wish to remove the green, and just leave red, 
place your mouse pointer over the green block, and 
two small icons will appear:

 The first icon, the dustbin, will allow you to delete 
that colour.

 The second icon will let you change the brightness 
or darkness of the colour:

(See Fig. 4.76)

 You can add up to five colours in each search.

 Underneath the “Slide dividers” is a text box that you 
can type in a word to further refine your search.

 The result you get may look like the image below; 
results of a TinyEye Multicolr search where we asked 
for pictures with 50 % yellow and 50 % blue.

(See Fig. 4.77)

2) Search for Creative Commons 

Licensed Content 

When searching for pictures, videos and audio on the 
internet you cannot always use what you find in your 
classes or your Blended Learning materials because au-
thors may not grant you the right to use it (or only when 
you have a contract with them). That’s were Creative 
Commons licensing comes in again. (For details on this 
see Section 3.4.) There is a website that offers search for 
visual and other material with special preference on ma-
terial that can be used under a CC licence.

 Go to the Creative Commons search page:

https://search.creativecommons.org

 Using this site, you will be able to search for a range 
of multimedia content.  The clue is:  this search en-
gine looks especially for content that is (likely to be) 
CC licenced, i.e. it is legally available to you to be 
used for developing educational content. (For de-
tails on CC see Section 3.4.)  Content that isn’t legally 
licensed won’t appear. Or at least that’s the idea. The 
Creative Commons organisation that runs the web-
site recommends its users to individually check the 
licence status of material retrieved, to be on the safe 
side.

 The site does not present you the result directly. 
Rather, you will be redirected to one of the site’s 
source sites (see list below), on which a search is ex-

Fig.  4.77 – Result of a picture search by colour, with settings 50 per cent blue 
and 50 per cent yellow.

Fig. 4.76 – TinEye colour selector wheel.
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ecuted with special parameters to possibly restrict 
results to such with Creative Commons licence. Such 
a search string can for example look like this (here 
we searched for European cultural heritage pictures 
of hamsters): Hamster AND RIGHTS:*creative* AND 
NOT RIGHTS:*nd*

 Search will be based on a range of websites with me-
dia repositories including:1

 Europeana.eu – the EU site for cultural her-
itage, including images, audio, documents, 
and video.

 Flickr – video and image hosting site.

 Google – text search.

 Google Images – Google image search.

 Jamendo – a music hosting site.

 Open Clip Art Library – an image library 
(openclipart.org)

 SpinXpress – an image and audio hosting site

 Wikimedia Commons – has text, images, au-
dio and video

 YouTube – a video hosting site you may have 
heard of

 Pixabay – an image and video hosting site

 ccMixter – a music hosting site.

 SoundCloud – a music hosting site.

To summarize: the Creative Commons Search website 
gives you quick access to various online databases with 
multimedia content, with a good chance to pick mate-
rial you are allowed to use in your lessons and for your 
blended teaching material to to Creative Commons li-
censing. 

Teaching Benefits

For certain learners, there can be great novelty and thus 
motivation in using multimedia content. For others, it 
may be confusing do deal with so much new things 
at once. You are the teacher or learning facilitator. You 
should know what is good for your learners. 

1 Information as in autumn 2018. In the meantime (May 2019) the website has developed further. The „old style search“ that 
included buttons to select these sources, is available only as a secondary option.

 When explaining intangible concepts, like magnetic 
fields, animation can help learners to get the idea. 

 Multimedia content can appeal to a wide range of 
learners, including those with a range of language 
abilities

 Multimedia content can encourage discussion and 
feedback

 Multimedia can help make learning personalised. 

Common Mistakes to Avoid

When using multimedia content, always ask yourself, 
what is the educational value of each element? It is 
very easy to add a wide range of multimedia content 
to teaching materials, but they must have a purpose to 
help the learners learn, so don’t add content unneces-
sarily.

 There is no need to clutter all the multimedia con-
tent in one place. You should spread the multimedia 
content over the lessons.

 Make sure you have the hardware resources (mem-
ory, and processor power) to store and display the 
multimedia content. 

 Make sure you have the correct viewers and players 
available for the learners to interact with the multi-
media content.

 Read one of Edward Tufte’s books.

Online or Offline?

 If you want to distribute  multimedia content offline, 
you can copy the content onto a USB memory stick 
and hand it out in class.

 If you and your learners have access to the internet, 
you have a lot of options to distribute your mul-
timedia content to your learners. You can share it 
with them using cloud storage (e.g. Dropbox, Goog-
le Drive, AWS, etc.), you can email it to them, if you 
have a website you can upload it there, or to a Virtual 
Learning Environment (e.g. Moodle, Blackboard, and 
Edmodo).
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4.6.2  Developing a Webquest

If you have been in contact with pedagogical studies 
in the past decade, you’ll be familiar with notions such 
as critical thinking, co-operative learning, digitalisation 
and authentic assessment. You have heard of the learn-
ing theories of cognitivism, constructivism, and recently 
also connectivism. If you are like many educators, you 
feel positive about new ideas for helping learners learn; 
but then you ask yourself how you could implement 
these abstract ideas in your everyday practice? Being 
motivation-rich but time-poor, how can we add these 
concepts in our adult education activities? Here is a sug-
gestion: try webquests.

Webquest – that’s a name for a method to facilitate 
learning processes in groups by bringing together the 
most effective instructional practices into one integrat-
ed learner activity based on self-directed exploration 
of a topic. Wow. That sounds complicated. So what is it, 
actually? 

In a more everyday type of language you could say: a 
webquest is research done in groups of learners using 
all possible sources of information, most prominently 
the internet (simply for practical reasons: the internet 
provides vast amounts of information instantly).  Some 
call webquests a learning facilitation strategy. As the 
word “web” suggests, the internet is  part of it; but so is 
also cooperation and exchange with others. These two 
things together make webquest a natural candidate for 
Blended Learning activities.

Webquests as a form of learning activity were devel-
oped starting from 1995 by a number of educators in-
cluding Bernie Dodge and Tom March around San Die-
go State University, California. Since then thousands of 
teachers have embraced webquests as a way to make 
use of the internet while engaging their students in 
the kinds of thinking that the 21st century requires. The 
model has spread around the world, so far especially to 
Brazil, Spain, China, Australia and the Netherlands.

In what follows we approach the topic in three ways: 

First, we outline a bit more of theory why webquests are 
a good learning tool aligned to the ideas of constructiv-
ism and connectivism. 

Second, we present a simple form of a webquest (so 
simple that it almost does not deserve the name) for a 
short Blended Learning activity. This can be implement-
ed as part of an ordinary classroom teaching lesson, or 

as Blended Learning homework plus subsequent pres-
entation and discussion in the classroom. 

Third, we relate you to some databases where you can 
find more elaborate webquests so see real-world exam-
ples beyond the superficial insight we can give you in 
this book. These are descriptions of blended learning 
activities that can take up to a week. 

The Theory Behind Webquests

Webquests are good learning tools because they use 
and promote learners‘ intrinsic motivation, learners‘ 
cognitive competences, and learners‘ ability to co-op-
erate with others. 

a) Motivation

Motivation is key to learning. WebQuests use several 
strategies to increase student motivation. 

First, good webquests use a central question (task) that 
honestly needs answering. Students are asked to under-
stand, hypothesize or problem-solve an issue that con-
fronts the real world, not something that only carries 
meaning in a classroom.

Second, when doing webquests, learners use real-world 
resources of information, not dated textbooks. Students 
can directly access individual experts, databases, cur-
rent reporting, and even fringe groups to gather their 
insights. Seen under this angle, doing a webquest with 
learners is like making them act as investigative journal-
ists. 

Third, when students take on roles within a cooperative 
group, they must develop expertise on a particular as-
pect or perspective of the topic. Their teammates count 
on them to bring back real expertise, and this boost mo-
tivation. 

b) Thinking skills 

Built into the webquest process are strategies of cogni-
tive psychology and constructivism. The question posed 
to students can not be answered simply by collecting 
information and spitting it back. A good webquest forc-
es students to transform information into something 
else: a comparison, a hypothesis, a solution, etc.
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However, learners should not be left completely alone 
with the task. You, the facilitator, should help them by 
breaking the task into meaningful chunks. You can ad-
vise them to undertake specific sub-tasks, to help them 
step through the kind of thinking processes that more 
experienced people would use. This form of support 
is called scaffolding. The challenge for you as an adult 
educator is to know your learners and their abilities 
very well so that you can provide suitable scaffolding 
to them. 

Constructivism claims that learning is a process in 
which the individual extends her existing knowledge 
by actively dealing with new situations. What students 
need are many examples with lots of information and 
opinions on the topic through which they will sift until 
they have constructed an understanding that connects 
to their individual prior knowledge. Webquests offer 
exactly such as rich playing field related to real-world 
tasks.

c) Co-operative learning

In good webquests, students cooperate in small groups 
to solve tasks with distributed responsibilities. This al-
lows webquests to tackle large, complex and contro-
versial topics. (Think of climate change, abortion, or the 
social responsibility that comes with wealth.) Nobody 
can be an expert in all relevant aspects of such a topic, 
but everybody can concentrate on one aspect, and con-
tribute expertise. This teaches also a lesson about how 
knowledge is organised in society in general. Moreover, 
if you run several webquest groups in the same class, 
students will also see that teams come up with different 
solutions. 

Summary

Putting the fancy word “webquest” aside, if you had 
to describe a webquest to your colleagues in standard 
terms, you could say: 

“I am doing with my students a form of project based 
learning. They get tasks they have to solve, ideally in 
groups. A larger part of the task is related to finding 
and assessing information; we mostly use the internet 
for this, but they can also use other resources, for ex-
ample the municipal library, or interviewing experts 
or whatever. Based on their research, they have to 
produce something, usually a written document like a 

1 http://questgarden.com

report or an article. The idea is to work self-directedly, 
and in teams, and the task they get should be relevant 
for them, so they do it with intrinsic motivation, not just 
because I say so. So, these are actually research pro-
jects with the purpose of exploring a topic. Depending 
on the topic, this can be done in one hour, or it can last 
several days.” 

Examples 

To give you some examples, here is a list of webquests 
prepared by teachers at colleges and universities in the 
USA in recent years and published on the Questgarden 
website for the benefit of everybody who wants to use 
(or further develop) them.1 We filtered the database for 
webquests made for an adult auditory (as opposed to 
students at school), dealing with the broader subject of 
economics and business. 

Aesthetics and Visual Design in Word Processing

You know good design when you see it. Let’s enhance 
your intuitive ability with a framework of principles on 
message and communication theory, design theory, 
and colour theory.

Macroeconomics

The economy is a complex being. In the blink of an 
eye, a booming economy can be hit with a crippling 
recession. For centuries, economists have been left 
wondering what is in charge of the market and how 
they can modify it. The goal of this webquest is for 
students to create an in-depth economic analysis of 
different aspects of global economies and determine 
what factors are helping and which ones are hurting 
them.

Pizza Project – Entrepreneurship Training

The purpose of this webquest is to teach students 
about some of the challenges that face entrepreneurs 
starting a new business including ways to identify 
a market, reach the market, and keep the market. 
The webquest follows many of the National Business 
Standards. Work is done in teams.

Build Your Budget! – Financial Skills Training 

Building Your Budget! is designed for students to 
learn, understand and practice the basics of building 
a realistic budget, and sticking to it. Students will learn 
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to evaluate all aspects of their spending, and create 
reasonable spending boundaries based off of their 
predicted income. 

Our recommendation is: visit the website, filter the 
webquests for a topic of your interest and read through 
four of five of them (Intro, Tasks, Process, Evaluation...).  
This will considerably improve your understanding of 
the idea of webquests. 

Here are now some more practice-oriented tips:

What do you need?

 Your learners should have computers and internet 
access.

 Good webquests are complex and need time. Al-
though it is possible to create very simply webquests 
that can be solved in an hour, the idea is rather to ex-
plore a topic more deeply, so 2-3 days of work for the 
learners would be a good orientation 

Where to look for help?

Internet resources: 

 The article Why WebQuests by Bernie Dodge and 
Tom March (the fathers of the webquest idea):  

https://www.internet4classrooms.com/why_
webquest.htm

 Web quest databases to look up good practice ex-
amples: 

https://www.quickbase.com/articles/the-complete-
guide-to-creating-web-quests

http://questgarden.com

 The Webquest Generator, an online tool to quickly 
draw a plan for a simple webquest:1

http://www.teach-nology.com/web_tools/web_
quest

1 Teach-nology is a website with online resources for teachers. Its services are free of charge. The service is financed via advertising 
and sponsorship. It is run by a small company in New York, USA. The website provides a broad range of materials and tools (in 
English), for example more than 30 000 ready made lesson plans in various subjects relevant for school teachers. –Just when 
we checked the WebQuest generator in Mai 2019, they had a programming problem on their site, and we are not sure when 
they will fix it.

Books on the topic:  

 Margaret M. Thombs, Maureen M. Gillis, Alan S. Can-
estrari (2008):  Using WebQuests in the Social Studies 
Classroom: A Culturally Responsive Approach. Corwin 
Publishers.

  Charles Wankel, Patrick Blessinger (2012): Increas-
ing Student Engagement and Retention using Online 
Learning Activities: Wikis, Blogs and WebQuests. Emer-
ald Group Publishing.

How do you prepare?

 The best thing to do first is developing a better un-
derstanding of what webquests are. This description 
here will definitely not be enough. You will need to 
see at least three or four real-life examples. Therefore 
we strongly recommend you to visit one of the vari-
ous webquest databases. These are websites where 
people publish their webquests for further use by 
others (addresses mentioned above). – With that 
understanding, the following steps  become self-ev-
ident: 

 Choose a topic for your webquest. For example, if 
your task is to lead a group of young adults through 
a process of learning how to make a business plan, 
then “Create a business plan” can be your topic. De-
pending on circumstances, you would narrow down 
your topic (“Create a business plan for a new pizza 
restaurant in your city”), or leave it open to increase 
complexity.

 Be aware that webquests can be as short as for one 
hour, or as long as for two weeks. It simply depends 
on what you are planning. 

 Break your topic down into manageable chunks 
that you can explain to your learners (see below, 
part “Process”). As part of this you will probably also 
identify a series of resources (online, or what ever is 
available) that will help students fulfil the task and 
thus automatically learn about the topic.
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What do I do?

Without this being a necessity or dogma, it has become 
a tradition to use the following structure to setup and 
present a webquest: 

 Introduction: provides the learners with back-
ground information: what is this webquest about, 
and why are we going to do it; what is the purpose 
general problem to be addressed. 

  Task: a summary description of what students are 
expected to do. – A good webquests offers a task 
that needs, for solving, thorough investigation of 
various topics. Moreover, a good webquest makes 
learners work cooperatively in groups with distrib-
uted roles for the individuals. However, there are 
also many webquests out there made to be solved 
by single learners, without much interaction with 
peers. That’s not the exact idea of a webquest, but, 
well, the world is not a perfect place...   

 Process: This is the breakdown of task in single 
steps, in detail. Here you provide learners with all 
information they need for getting started, and for 
working through the various phases of the task. This 
can be detailed description of sub-tasks, hints for 
helpful sources of  information, and general require-
ments for the product students are invited to deliver. 
Also you would ideally include advice about distri-
bution of work to different people in the team. (For 
example, in a webquest with the aim of developing 
a business plan for a new restaurant, teams may con-
sist of a boss, an office manager, a marketer and a 
finance guy.) You can offer advice on how to manage 
time, collect data, and provide strategies for working 
in group situations.

 Resources: Links to websites and videos, or clues to 
tools that will help learners complete the task. (If not 
already included in the “Process” part). Sometimes it 
can be necessary to provide materials such as pre-
pared readers with crucial information on a topic, a 
glossary of core terminology to get acquainted with, 
mathematical tables or other things for download. 

 Evaluation: Here you lay out your criteria: what is 
needed for the webquest to be considered well-
solved? For example, if part of the solution is provid-
ing a written document (as essay, a business plan, a 
news article, a CV...), probably correct spelling and 
grammar are first (but not sufficient) requirements 

for a good rating. Criteria really depend on the topic. 
– It is common practice to organise criteria in form of 
a table, like “solved excellent if..., solved acceptably 
if... solved badly if...“ (see examples in webquests 
published on http://questgarden.com).  

 Conclusion: Here you sum up the task. 

You find an example for a webquest described in a grid 
like this on the next pages. But do not take this as man-
datory or as too prototypical. You can of course use a 
completely different system of describing the task to 
your learners for organising their work. 

Teaching Benefits

 Webquests can be a novelty and thus a source of 
motivation. 

 They encourage learners to develop independent 
study skills.

 They encourage a structured use of web resources.

 They accommodate a wide range of learner needs.

 They can be done individually or in groups.

Caveat: as a teacher in adult education, you probably 
have already understood that the concept of webquests 
was developed initially mostly in traditional school en-
vironment. Webquests are certainly not appropriate 
for all groups of learners in your adult education cen-
tre because often your participants prefer other forms 
of interaction. However, for certain groups of learners 
and for certain subjects, webquests may anyway be a 
suitable method. 

Common Mistakes to Avoid

 Try to make sure each of the phases are clearly ex-
plained, and the “Process” phase covers enough in-
formation to complete the task. 

 Ensure all learners have access to computers and 
sufficient connectivity to complete the WebQuest

 Try to make sure the students don’t lose focus and 
end up wandering around the internet with no pur-
pose
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 The first webquest needs to be easy to complete, 
and a success for all learners, otherwise some will be 
put off.

Online or Offline?

Learners need internet access to do the research part 
of a webquest. – If the webquest is part of a Blended 
Learning arrangement, this is of course anyway  a given.

***

On the next page you find a template you can use to 
quickly create WebQuests for your learners.  

The form is also included in the collection of supple-
mentary documents to this book: 

BL_Sup02_WebQuestTemplate.docx
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Blend-it-well Handbook 

Webquest

Title Blended Learning - What is it?

Subject Area

Tutor Franziska Maier-Müller

Academic Year

1. Introduction

“Blended Learning” has become something like a buzz 
word. But not everybody has a clear idea what it actually 
is, or what people who use it mean by it.

2. Task
Learning is. 

dictionary, to explain it. 

3. Process

Search in the internet for suitable sources. 

Read them, and take notes of things that seem important to 
you.

 -
work. 

 -

minutes for research and writing.
 - Print your article  

4. Resources

useful. 

 - Wikipedia
 -
 - The website www.blenditwell.eu 

5. Evaluation (anonymously) compare them (method for this will be 
explained by teacher) and discuss which is best, and why. 

6. Conclusion “Blended Learning?” - Let’s discuss.

Fig. 4.78 – Example for a very simple WebQuest concept, using the WebQuest planning form available next page.  
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WebQuest 

 

 

<Picture  
illustrating 
 the topic > 

 

Title  

Subject Area  

Tutor  

Academic Year  

1. Introduction  
 
 
 
 

2. Task  
 
 
 
 

3. Process  
 
 
 
 

4. Resources  
 
 
 
 

5. Evaluation  
 
 
 
 

6. Conclusion  
 
 
 
 

Fig. 4.79 – You can use this form to create a simple WebQuest activity for your learners. (You can do this of course also without 
this form; the form is meant only to remind you of the most crucial issues to be thought about.) This form is availabe also in the 
collection of forms (supplement to this book) at www.blenditwell.eu/handbook/templates/BL_Sup02_WebQuest.docx 
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